
Help Index

The Index contains a list of Smartcom help topics.    You can maximize the Help window with the maximize button 

, and then resize it with the resize button 
.    You can also drag the borders to reshape the window, and use the scroll bar to view information that doesn't fit. 

And you can use    the 

 button to access a comprehensive list of topics you can quickly jump to.

For additional information on how to use Help, press F1 or choose Using Help from the Help menu. 

Smartcom Help is organized into these general categories:

Procedures
· Main Buttons
· Program and Script Startup Options
· Settings and Online Techniques
· Starting a Connection

Commands
· File Menu
· Edit Menu
· Connection Menu
· Settings Menu
· SCOPE Menu
· Special Menu

Miscellaneous 
· Keyboard
· Terms



Communications Documents and Settings

Each remote system you communicate with has unique characteristics.    For example, every system you call has a 
different telephone number.

For each remote system you communicate with, you can create custom settings that tailor Smartcom to the system.    
Each collection of settings you create is called a communications document.    You then use the File menu to Save 
the document to disk for reuse each time you want to communicate with that remote system.    When you want to use 
the document to communicate with the remote system it was designed for, you Open it. 

Communications Documents

Communications documents are collections of settings that tailor the program to accommodate unique remote 
systems you communicate with.    The settings are adjusted with selections from the Connection and Settings menus, 
and then saved on disk in documents for re-use.    Ordinarily you'll use a separate communications document for 
each remote system. 

Communications documents are managed with the File menu.    To communicate, a document must be Open. 
Smartcom displays the name of the open document on the title bar. 

If you change a setting that you want to make permanent, save your change.    For a new document, select Save As... 
from the File menu.    To save changes to an existing document under the existing name, select Save from the File 
menu.

To start a new document, select New from the File Menu.    This opens a document named Untitled.    The Untitled 
document contains standard settings that work with most remote systems.

Note that you can only work with SCOPE scripts in a named document, as a script must be associated with a 
document on disk.

The Most Often-Used Setting Options

An Untitled communications document you open with the File menu's New option contains settings that 
accommodate most remote systems.    However, some of the settings require adjustment more frequently than others, 
and this listing describes them:

· Phone number on the Connection menu specifies the number to dial when you're making a connection by 
originating a modem call.

· Originate and Answer: These options, located on the Connection menu, let you specify whether you want to 
place a phone call (by dialing) or answer a call.    Originate dials; Answer waits for an incoming call.

· Connect Through Phone and Direct Connect specify the type of connection you want to make.    Connect 
Through Phone is most common, using your modem to communicate with a system over the phone lines.    
Direct Connect is used to connect, without a modem, directly to a system.    For example, you'd use this setting 
when connecting by cable to another computer.    When connecting directly, you need to use a specific speed 
setting that agrees with the one being used by the other computer.    (See the Speed & Format discussion below.)

· Terminal on the Settings menu selects the type of display method Smartcom uses.    This display method is called 
a terminal emulator.    Smartcom can make your computer screen adapt to the display methods used by various 
remote systems.    TTY is often used, and ANSI is frequently the emulator of choice for bulletin board systems.

· Speed & Format on the Settings menu specifies how fast information is transmitted and received and how 
information is formatted.    For Speed, Maximum is the most usual selection, because Smartcom determines the 
fastest speed appropriate for your modem brand and type.    During the process of connecting to the remote 



modem, Smartcom attempts to use the fastest speed at which both modems are capable of communicating.    
Format specifies one of the standard methods by which computers encode information.    Eight Bits per 
character, One Stop bit, and None for Parity constitutes the most common format.    Seven Bits per character, 
One Stop bit, and Even Parity constitutes another frequently used format. 

Other Items Stored in Communications Documents

In addition to settings, a communications document can also contain these items:

· SCOPE scripts that perform tasks automatically

· Buttons that provide a convenient way to access features that automate operations.    You can create your own 

buttons, just like the  (Phone) and other buttons displayed at the bottom of Untitled and newly created 
documents.    Custom buttons can start a script, for example, or execute a menu selection, and all you have to do 
to perform the action is click the mouse on the button.

· Window position information that remembers your preferred arrangement of windows and buttons

Getting Session Status

Smartcom keeps track of statistics about the current communications session, including connect time for the session 
and for the day, and information about communication settings in effect.    To access this information, double-click 

on the status bar  located in the bottom left of the horizontal scroll bar. 



About the Peruse Buffer

While reviewing previous information, new information continues to be processed until the memory limit is reached. 

When the disk space allocated for the peruse buffer fills (256K), incoming data begins to replace data received 
earlier. Once overwritten, the older information cannot be recovered. Therefore, you should use the Disk Capture or 
Printer Capture button to save all the data you want to retain. 

See also: Buttons.



Quick Settings

Program settings allow you to adjust Smartcom to communicate compatibly with various types of remote systems.    
Of these, Quick settings are the ones that most often require adjustment.    For your convenience, they are located not 
only on Smartcom menus arranged by category, but are also grouped together on one dialog box.    To access this 
dialog, use the Quick command on the Settings menu.



Quick Settings Dialog

These settings are grouped together under on one dialog box for your convenience.    Most are also accessible by 
other menu selections, which are organized by category.    Whether you adjust the settings here or on other dialog 
boxes, when you use the File menu's Save or Save As command, the settings are saved with the document. 

These Quick settings are grouped in this dialog box:

· The Description box lets you title the communications document.    This title appears on the Phone Book listing 
you can select from the Connection menu. 

· Terminal Emulator (also adjustable by selecting Terminal on the Settings menu) selects the type of display 
method (emulator) Smartcom uses.    Smartcom can make your computer screen adapt to the display methods 
used by various remote systems.    TTY is often used, and ANSI is frequently the emulator of choice for bulletin 
board systems.

· Connection Type lets you select the type of communications link you're using to connect to the other system.    
Connect Through Phone and Direct Connect are the most common. 

· File Transfer Protocol specifies the type of error free protocol to be used for file transfers.    You can also make 
this selection, and fine tune how the protocol works, with the Settings menu's File Transfer Protocol option.

· Phone number (also on the Connection menu) specifies the number to dial when you're making a connection by 

originating a modem call.    You can use the  button to display the Edit Phone Number List dialog box, 
in which you can enter in or select from multiple phone numbers.

· Transmission Speed (baud) and Bits per character select the data transfer rate and character format for 
computer information.    These settings are also available under the Settings menu's Speed & Format selection.    See 
that topic for more details.

Other Items Stored in Communications Documents

In addition to settings, a communications document can also contain these items:

· SCOPE scripts that perform tasks automatically

· Button sets that provide a convenient way to access features that automate operations.    You can create your own 

buttons, just like the  (Phone) and other buttons displayed at the bottom of Untitled and newly created 
documents.    Custom buttons can start a script, for example, or execute a menu selection, and all you have to do 
to perform the action is click the mouse on the button.

· Window position information that remembers your preferred arrangement of windows and buttons

Getting Session Status

Smartcom keeps track of statistics about the current communications session, including connect time for the session 
and for the day, and information about communication settings in effect.    To access this information, double-click 

on the status bar  located in the bottom left of the horizontal scroll bar. 



Capture to File Dialog

When you click on  to capture information to disk, and you haven't selected anything in the peruse buffer, the 
information you exchange with the remote system from that point on is sent to a file on disk.    It continues to be 
added to the file until you click on 

 again to stop disk capturing.

First you are presented with a dialog box in which you specify the name of the file to store the information you are 
capturing.    After you specify the file, the disk capturing begins.

Smartcom suggests an appropriate capture file name, but you can use any name you want, that of a new file or an 
existing one.    Type the name of the file or select it from the list.    You can narrow the list down with DOS wildcard 
characters, for example, type *.TXT in the File Name box to list only files with that file name extension.

If you select the name of a file that already exists, Smartcom lets you append the new information to the bottom of 
the file, replace the file's contents with the new information, or cancel.

You can select a disk and directory, as needed, using the Drives and Directories boxes.    The File Type list lets you 
specify a file format.    Select:

· Filtered to capture only ASCII characters, and filter out line drawing and other special characters.    Only 
printing characters, spaces, carriage returns, line feeds, and tabs are included.    Tabs are changed into five space 
characters.

· Byte for byte to make Smartcom capture data exactly as it is received.

· ANSI to include special text attributes used by many bulletin board systems, such as colors, blinking and reverse 
text, and graphics characters.    (This is essentially the same as Byte for byte, except that Smartcom suggests you 
use a file name extension .ANS.)



Capture to File Dialog

When you select information in the peruse buffer and then click on  to capture the information to disk, you are 
presented with a dialog box which lets you specify the name of the file to receive the captured information. 

Smartcom suggests an appropriate capture file name, but you can use any name you want, that of a new file or an 
existing one.    Type the name of the file or select it from the list.    You can narrow the list down with DOS wildcard 
characters, for example, type *.TXT in the File Name box to list only files with that file name extension.

If you select the name of a file that already exists, Smartcom lets you append the new information to the bottom of 
the file, replace the file's contents with the new information, or cancel.

You can select a disk and directory, as needed, using the Drives and Directories boxes.    The File Type list lets you 
specify a file format.    Select:

· Filtered to capture only ASCII characters, and filter out line drawing and other special characters.    Only 
printing characters, spaces, carriage returns, line feeds, and tabs are included.    Tabs are changed into five space 
characters.

· Byte for byte to make Smartcom capture data exactly as it is received.

· ANSI to include special text attributes used by many bulletin board systems, such as colors, blinking and reverse 
text, and graphics characters.    (This is essentially the same as Byte for byte, except that Smartcom suggests you 
use a file name extension .ANS.



Receive File 

The Receive button receives a file error-free using the current File Transfer Protocol.    This is selected at the 
Settings menu.

A file transfer protocol is like a language.    Both parties in the communication must use the same one.

When using ZMODEM, there is no need to use the Receive File icon to begin receiving files.    When the sending 
computer begins the transfer, Smartcom automatically begins receiving.    (This feature can be turned on or off with 
the ZMODEM Protocol Settings box.



Autotype File Selection Dialog

When you use the  Autotype button to transmit text, you're presented with a dialog box in which you can 
specify where the text is to be found.

In the File Name box, enter the name of the file to autotype.    To locate files in other directories or on other disk 
drives, use the Directories box to move through your directories, and the Drive box to select disk drives.    For 
details on selecting file names, directories, and disks, see the topic Using Browse Screens. 

The File Type box lets you focus on only the files you want listed.    Select Filtered (*.*) to list all files, and to then 
filter out non-text characters during the autotyping process.    (This specification lets you override the 
communications document's Autotype Protocol filter setting.)    Select Byte for Byte (*.*) to list all files, and then 
autotype the selected file without any filtering.

You can also select an autotype protocol with the drop down box.    Normally Smartcom uses the communications 
document's autotype protocol selection, but the box lets you override this on the fly.    Pull down the box to select the 
protocol.    Click on a protocol on the list below for information specific to the protocol (keyboard: Tab and Enter):



Settings Menu

Use the Settings menu to make both computers compatible and fine-tune the way the screen, keyboard, modem, and 
file transfers work.    When settings are adjusted to accommodate a remote system, you can save them to disk as a 
communications document you can reuse each time you call that system.    Since each remote system is different (if 
only by the phone number), you'll typically have a separate communications document for each remote system. 

Click on a menu item for help on it (keyboard: Tab and Enter):



SCOPE Menu

SCOPE scripts automate repetitive communications tasks such as logins to information services and bulletin boards. 

Click on a menu item for help on it (keyboard: Tab and Enter):



Special menu

The Special menu is provides miscellaneous, extra Smartcom features.    You can create your own buttons, send a 
break signal to a remote system, and reset the terminal emulator. 

Click on a menu item for help on it (keyboard: Tab and Enter):



Glossary

ASCII
Autotype Protocol

Batch File
Baud
Bits Per Character
Break

Carriage Return
Carrier
Character
Character Format
Clipboard
Communications document
Control Character (Control Code)
CPS

DCE
DCE Speed
DTE
DTE Speed

Emulation (Terminal Emulation)

File Transfer Protocol
Flow Control

Hardware Flow-Control

Line Feed

Parity
Peruse Buffer
Protocol

SCOPE
SCOPE script
Start/Stop Flow Control
Stop Bits

Terminal
Transmission Speed
Transparent Xon/Xoff Flow-Control

Xon/Xoff Flow-Control



File Save As

Use the File menu's Save As command to save a duplicate of the open communications document to disk under a 
different name.    The new document becomes the open document, and its name is displayed in the Title bar.    (If you 
select Save at the File menu while an Untitled document is open, Smartcom assumes Save As, so you can provide a 
different name.)

In addition to a file name, you can also specify a file type, disk, and directory for communication document storage.



Connect Through Phone 

The Connection menu's Connect Through Phone selection specifies you're using a modem and phone line to make 

a connection.    When you click , Smartcom will either Originate (dial out) or Answer a call, depending on 
which of these is selected on the Connection menu. 



Connection Originate 

The Connection menu's Originate setting specifies that Smartcom places an outgoing call, by dialing with the 

modem, when is clicked.

Originate is selectable only when Connect Through Phone is set on the Connection menu.



Connection Choose Port 

The Connection menu's Choose Port option selects the computer communications port to be used for a connection. 

Typically, you'll use the same port for all your communication sessions.    Therefore, by default, the port selection 
applies to all existing documents and all new documents you create.    In this case, leave  selected.

If you use different ports for communications, you can select  to apply your port selection only to the 
one document.    Other documents can then be used for communications via other ports.



Settings Speed & Format

The Speed & Format command on the Settings menu specifies the character format (also called data format), the 
transmission speed (also called baud rate), and flow control used for communications.

Transmission Speed

Transmission Speed is also termed Baud Rate or Bits Per Second.    Typically the transmission speed is negotiated by 
the two modems while they're connecting.    The setting Maximum instructs Smartcom to use the fastest speed the 
two modems are capable of using, and this setting is appropriate for almost all modem connections.

You only need to select a specific transmission speed when:

· using a direct connection
· connecting to a system using a modem or software that can't adjust to changing speeds
· using the reduced modem command set
· originating a call with a Smartmodem 1200 to a Smartmodem 300. 

For the first three cases, select the same speed the remote system uses.    For the last case, select 300 bps. 

Character format

Character (or data) format is a term used to described the way a computer constructs a character of information, 
called a byte.    A byte consists of character bits, one or two stop bits, and may use a parity bit.    These settings 
usually don't need adjustment, but they do have to match the format used by the remote system.    The standard 
setting of Eight Bits per character, One Stop bits, and None for Parity is the most frequently used.    Some systems 
use Seven Bits per character, One Stop bit, and Even for Parity.    Sometimes the best way to determine the correct 
settings is to contact the remote system's operator or review an information service's literature.

Bits Per Character

Eight is the most common number of Bits Per Character, but Seven is required on some systems.    When using eight 
character bits, it is standard (though not universal) to use one stop bit and none for parity.

Stop Bits

One is the most common number of Stop Bits.    Two Stop Bits are rarely used, except at low speeds such as 110 and 
300 bps.

Parity

None is the most common Parity setting.    Even parity is used more frequently than Odd.    Mark and Space parity 
are rarely used, and are valid only with seven bits per character. 

Flow control

Flow control is a method by which communications programs pause and restart information transmissions so that 
the receiver can keep up with the sender, preventing loss of data.    Flow control therefore is important when 
autotyping a text file or when Smartcom is receiving information from the remote system.    The Start/Stop protocol, 
also called Xon/Xoff, is the most commonly used type.    With Stop/Start, Control-S (Xoff) pauses communications, 
and Control-Q (Xon) restarts.

If Smartcom continues sending after the other computer attempts to stop it (by sending a Control-S), make sure your 
character format matches what the other computer expects.    If it doesn't, the computer may not recognize the flow 
control characters.    You can use the Show controls terminal emulator, selectable with the Settings menu's Terminal 



option, to display control characters and view how the two systems interact with them.

Although Stop/Start is the most commonly used method, hardware flow control (RTS/CTS or DTR/DSR), if usable 
by both systems, tends to be more efficient.

If the device you're connected to doesn't support either Xon/Xoff or Hardware flow control, you may have to use 
None.    When autotyping a file, you can introduce delays, if necessary, through the Autotype Protocol settings. 



Maximum port speed to modem

The Maximum port speed to modem setting on the Modem Settings dialog box, accessed from the Settings menu, 
lets you limit the serial port speed of your computer.    This transmission rate between your computer and your 
modem is known as the DTE speed.    This speed may be different from the speed at which your modem is 
communicating with the remote modem (the DCE speed).    In Smartcom, the DCE speed is set through the 
Transmission Speed setting.

For error-correcting modems with data compression, Smartcom automatically sets the port speed.    This speed is 
usually much higher than the speed at which the modems communicate. This can result in dramatically increased 
performance. For example, an error-correcting 2400 modem with data compression can perform almost as fast as a 
9600 modem, so the DTE speed is set much higher than the DCE speed.

Typically, modem control logic in Smartcom dynamically selects a port speed that provides optimal performance.    
When the default setting No Limit is in place, this is what usually happens.    On occasion, however, your computer 
may be unable to keep up with a very fast modem connection.    You can try experimenting with flow control settings 
to see if they can resolve the problem.    If flow control adjustments can't fix the problem, you may need to limit the 
port speed to a specific rate.

When the Maximum port speed to modem setting is in place, Smartcom never exceeds the specified limit.    
However, it may drop to a lower speed.    In some cases, you won't want this to happen.    To use one, constant speed, 
check the Always use this speed button.

See also
Advanced settings.



Always use this speed

When the Modem Settings dialog's Maximum port speed to modem box is checked, Smartcom will never 
dynamically adjust the port speed above the setting's specified limit.    However, it might drop below it.    If you need 
to keep a constant speed that never changes, use the Always use this speed on the Modem Settings dialog box, just 
below the Maximum port speed to modem setting.



Emulator

A terminal emulator is a standard method by which a communications program makes a computer behave like a 
terminal.    This involves interpreting codes from the remote system and translating certain keystrokes so that your 
screen displays properly and the remote system interprets keys correctly.    Select Terminal at the Settings menu to 
choose an emulator compatible with the remote system.

TTY emulation is the most common form of terminal emulation.

If the other computer expects to be connected to a VT52 or VT102 terminal, select the VT102 setting.

The ANSI BBS emulator displays colors and IBM PC graphics characters used by many bulletin board systems. 
When using the ANSI emulator, the colors requested by the remote system override any screen color choices you 
may have active.

Sometimes using the wrong emulation setting can result in the appearance of garbled characters.    If this happens, 
you may be able to consult a service or bulletin board system's on-line documentation to determine which emulator 
to use.    Or contact the remote system operator to inquire.



Send Line Feed with each Return

Computers normally start a new line in two steps: with a carriage return character, which places the cursor at the 
beginning of a line, and a line feed character, which moves the cursor down one line.

If lines of text you type and autotype are written over each other when received by the remote system, you need to 
send a line feed character as well, and should select this option.    Normally the characters you see on the screen are 
echoed from the remote system, so lines will appear to write over each other on your screen, too, letting you know 
you should select this option.

Deselect this option if the lines you type are double spaced. Double-spaced lines sometimes occur when 
communicating with an information service.

At the Settings menu, select Terminal to access this option.



Display Incoming Data with Line Feeds

Computers normally start a new line in two steps: with a carriage return character, which places the cursor at the 
beginning of a line, and a line feed character, which moves the cursor down one line.    If lines of information you 
receive from the remote system write over one line instead of progressing to new ones, turn this option on.

If incoming lines are double spaced, turn this option off.

At the Settings menu, select Terminal to access this option.



Maximum line length is € characters

This setting controls the maximum number of characters that can appear on one line.    If characters exceed the 
length specified here, they are wrapped to the next line (if Autowrap is turned on) or discarded (if Autowrap is off). 

Set this value higher if you need to display more characters per line, such as when your display is emulating a 132-
column terminal.

At the Settings menu, select Terminal to access this option.



Autotype Protocol and Settings

Autotype Settings specify how text information is autotyped and captured to disk.    Options in this dialog box let 
you:

· Specify the flow control protocol used for autotyping and capturing to disk

· Filter non-standard (extended ASCII) characters from autotyped files

· Send ANSI sequences, which let you preserve special text formatting in ANSI files you autotype when 
communicating with a system that uses the ANSI emulator

After selecting your autotype protocol and options in this dialog box, you can fine tune your autotype protocol 

selection with the  button.

Autotype Protocol

The autotype protocol is a flow-control protocol.    This type of protocol is designed to pace text transmission so that 
the sender does not transmit information too fast for the receiver to process it.    The flow-control protocol supervises 
information flow when Smartcom autotypes text to the remote system and when it captures information to disk files. 
It's also used when you send information with the Edit menu's Paste command.

Normal is the standard selection, and has two purposes.    Most often it used to select no special autotype protocol.    
Text transfer is paced using the flow-control protocol selected for all the communication document's text 
transmissions, which includes what you type at the keyboard.    The document's flow-control protocol is selected 
with the Settings menu's Speed & Format option.    Note that if you select None for your flow-control protocol in 
Speed & Format, and Normal for your autotype protocol, no protocol is used at all, and Smartcom transmits text as 
fast as it can.

Its other purpose is to let you slow down text transmissions using a time delay between the transmission of each 
character.    This option is typically only used when you're online with a system that doesn't implement any of the 
selectable document flow-control protocols or autotype protocols.    To introduce a time delay, use the Protocol 
Settings button.

Send lines protocol is for use with systems that receive information a line at a time.    Many remote system text 
editors and electronic mail editors work this way.    Each time you finish a line of text, you press a carriage return to 
begin the next line.    When autotyping a file, Smartcom knows the remote system is ready for the next line when it 
receives a line feed character.    If the remote system begins each line with a prompt character, such as a > or :, you 
can adjust the character Smartcom looks for with the Protocol Settings button.

Await character echo is for use with systems that don't implement one of the communication document flow-
control protocols or the autotype Send Lines protocol, but do echo back characters to you.    Each time Smartcom 
receives an echo of the last character it sent, it knows the remote system is ready to receive the next character.    You 
can fine tune the pacing of this text transfer method with the Protocol Settings button.

Filter Options

With this option, you can include or exclude extended ASCII characters in the files you autotype.

Extended ASCII characters are those that are not part of the standard set of ASCII 0-127.    The standard ASCII set 
consists of letters, numbers, punctuation, and some standard control codes used by computers for various purposes. 
Allowing extended ASCII permits inclusion of an additional set of characters, consisting of international characters, 
line drawing characters, and other special symbols.



To include extended ASCII characters, select None.    To filter them, select Control and character set processing.

Send ANSI sequences by default

Checking this box lets you include special character attributes (which are part of the ANSI terminal emulation 
method) when you autotype files.    When checked, the special attributes are also included in files you capture to 
disk.    You may want to check the box to include the special attributes in a disk file captured from a remote system 
that uses ANSI emulation, such as a bulletin board system.



Protocol Settings for the Send Lines Protocol

You can fine tune the way the Send Lines protocol works with Protocol Settings.    This box is accessed by selecting 

Autotype Protocol from the Settings menu, darkening Send Lines, and clicking the  button.

Look for

The Send Lines autotype protocol transmits text files a line at a time.    Smartcom knows the remote system is ready 
for a new line of text when it receives a line feed character, used by computers to indicate the start of a new line.    
Sometimes, however, the remote system will start each new line with an additional prompt character, such as > or :, 
or a message such as Ready.    If this is the case, Smartcom will send characters on receipt of the line feed character, 
and, if the remote system is busy preparing the prompt character, the remote system might lose one or two characters 
at the beginnings of lines.

So if the remote system starts each line with a prompt, and you notice that sometimes one or two characters at the 
beginnings of lines are lost, you can change the character or characters Smartcom Looks for.    Enter the prompt 
character the remote system inserts at the beginning of each line as your Look for setting.

Once in a while, the remote system ends its prompt with a formatting or emulator character not normally displayed, 
such as a Tab.    To enter a Tab, press Ctrl-I in the Look for box.    To enter a carriage return, press Ctrl-M.    Other 
special characters can be entered using the Ctrl key and letters.

Continue anyway after € idle seconds

After autotyping a line of text, Smartcom waits this length of time for the remote system to send the specified 
prompt character.    If the character isn't received in this length of time, Smartcom assumes the character lost in 
transit and autotypes the next line anyway.    For very slow remote systems, you can set this value higher.



File Transfer Protocol

When you click on the  or 

 button, you are instructing Smartcom to transfer a file to or from the remote system using error-free methods 
to ensure the integrity of the transfer.

File transfer protocols are the methods used by two cooperating systems to ensure that files are transferred without 
errors.    When transmission errors occur, the receiver and sender can determine this, and correct the problem by re-
transmitting the information that was affected.

There are various methods for ensuring error-free transmissions, and Smartcom lets you select from some of the 
most popular.    They are:

· XMODEM
· XMODEM CRC
· XMODEM 1K blocks
· ZMODEM

When selecting a protocol, the most important thing to keep in mind is that both the sender and receiver need to 
select the same protocol.    ZMODEM is popular and efficient, and so it is the standard setting for new 
communications document.    If you need to select a different protocol, at the Settings menu select File Transfer 
Protocol...

Pull down the list to select a protocol.

You can also use the  button to specify a default directory to be used for file transfers.    The default 
directory is the first one Smartcom suggests to you when you're selecting where to store a received file or locate a 
file to send.



XMODEM

This is a basic file transfer protocol supported by a large installed base of computer systems.    It is less efficient than 
other variations of XMODEM, YMODEM, or ZMODEM, but is selectable for use with systems that don't support 
the more efficient protocols.

You can use the Ack-ahead option to speed up transfers for reliable connections.    It should only be used with 
reliable connections such as those between error-controlling modems or direct connections, because, if an error is 
detected, the transfer is halted.    For most non-error-controlled phone connections, you should leave this unchecked, 
because, when an error is detected, the affected information will be retransmitted and the transfer will continue.

When sending, you're presented with a dialog box in which you select the disk and directory, as needed, and then 
pick out the file you want to send.

You can fine tune the way the protocol works with the Protocol Settings button.



XMODEM CRC

XMODEM CRC is a variation of the basic XMODEM protocol.    It is statistically somewhat more reliable than 
standard XMODEM.    It is less efficient than XMODEM 1K or ZMODEM, but is selectable for use with systems 
that don't support the more efficient protocols.

You can use the Ack-ahead option to speed up transfers for reliable connections.    It should only be used with 
reliable connections such as those between error-controlling modems or direct connections, because, if an error is 
detected, the transfer is halted.    For most non-error-controlled phone connections, you should leave this unchecked. 
When it is unchecked, and an error is detected, the affected information will be retransmitted and the transfer will 
continue.

When sending, you're presented with a dialog box in which you select the disk and directory, as needed, and then 
pick out the file you want to send.

You can fine tune the way the protocol works with the Protocol Settings button.



XMODEM 1K blocks

XMODEM 1K blocks is a more efficient variation of the XMODEM CRC protocol.    XMODEM 1K blocks is more 
efficient because it transfers information in larger (1024-byte) blocks.    It is statistically somewhat more reliable 
than standard XMODEM.

You can use the Ack-ahead option to speed up transfers for reliable connections.    It should only be used with 
reliable connections such as those between error-controlling modems or direct connections, because, if an error is 
detected, the transfer is halted.    For most non-error-controlled phone connections, you should leave this unchecked, 
because, when an error is detected, the affected information will be retransmitted and the transfer will continue.

When sending, you're presented with a dialog box in which you select the disk and directory, as needed, and then 
pick out the file you want to send.

You can fine tune the way the protocol works with the Protocol Settings.



Receive File Name

On using the  Receive File button to receive a file error-free from the remote system, you're presented with a 
dialog box in which you can specify the file name to be received. 

If you're using ZMODEM, the system you're receiving from will send the name of the file with the file.    There is no 

need to specify a File Name if you want to use the one the remote system suggests.    Just leave the  
box unchecked.    If you want to specify your own file name, check the 

 box and fill in the File Name box.    (Note: If the remote system is sending a batch of files, the first 
one takes the name you give it.    Others take the suggested remote system file names.)

When using XMODEM, XMODEM CRC, or XMODEM 1K, the  box is not used and you need to 
supply a File Name.    You can't use wildcards such as *.*.

To specify a different drive or directory to store the received file(s), use the Directories box to move through your 
directories, and the Drive box to select disk drives.    For details on selecting file names, directories, and disks, see 
the topic Using Browse Screens. 

Because you're using an error-free protocol, you can send files of any type, so the List Files of Type box will permit 
selection of All Files (*.*)

You can use the Protocol drop down box to change from the current communications document's file transfer 
protocol to another.    When a protocol is selected that permits names to be sent with files, *.* is suggested for the 
File Name.    When a protocol is selected that doesn't send file names, the name changes to RECEIVED.

Whether the File Name box lists RECEIVED or *.*, you can change to any valid file name. 

When file name, directory, disk, and protocol specifications are correct, use the  button to receive the 
file.



Send File Names

On using the  Send File button to transmit a file error-free to the remote system, you're presented with a dialog 
box in which you specify the file or files to be sent.

Smartcom supports multiple file transfers when you're using ZMODEM. 

Use the Directories box to move through your directories, and the Drive box to select disk drives.    For details on 
selecting file names, directories, and disks, see the topic Using Browse Screens. 

You can double-click on the file name or click on it and use the  button to place the file on the list.    
You can use DOS wildcard characters to specify file groups.    When ready to send the files, click on 

 or press Enter.

To remove files from the list, highlight them and use the  button.

If you build a list of files that you'll be using again, you may want to use the  button to keep a copy.    
Smartcom by default saves the list with the file name extension .SCB for Smartcom Batch.    You can also build a list 
using the Windows Notepad or with your favorite text editor or word processor, so long as the file is saved in text-
only mode.

To use a pre-made list, use the  button and select the file containing the list of file names.

You can mix the adding of files and lists to build a bigger list.

When ready to send the group of files, click on  or press Enter.

You can use the Protocol drop down list to select a different protocol.    If you switch from a protocol that supports 
multiple file transfers to one that doesn't, or vice versa, the Send File dialog box changes appropriately.



Add List

You can add an entire list of files to the Send Files box quickly with the  feature.    Prepare ahead of time 
a text file containing a list of file names to be sent.    You can do so with any text editor such as Windows Notepad.    
Or build a list by manually selecting files to send, and then use the 

 button to save it as a text file with the file name extension .SCB (for Smartcom Batch).

Smartcom initially lists files with the .SCB extension for your selection.    However, if you save your batch text files 

under another extension, you can type the extension in the File Name box and select  to list those files.    
For example, type *.* to list all files.

When locating the batch file containing the file list, use the Directories box to move through your directories, and 
the Drive box to select disk drives.    For details on selecting file names, directories, and disks, see the topic Using 
Browse Screens. 

You can add multiple batch files to build very long lists of files to send, and mix manual file selection with batch file 
additions.



Keyboard Map

Keyboard Map, selected at the Settings menu, lets you view and print all the Smartcom key combinations that 
perform program actions.    This provides a quick reference help to all the shortcut keys.

You can view current key assignments sorted by either Key Combo or by the Action the keys perform.    To do so, 
darken the appropriate button.

Select Print List to print a list of all the current key assignments.



Preferences

The Preferences selection on the Settings menu customizes Smartcom to your tastes.    You can adjust program-wide 
operations and those particular to a communications document.

Display alert on connection lost

When this is checked, Smartcom displays a message to alert you when the connection is broken.    Uncheck this box 
if you don't want the message displayed.

Display alert on data overrun

When this is checked, Smartcom displays a message to alert you when the computer's hardware can't process 
information fast enough to keep up with the speed of the connection.    When the computer's processor or serial port 
can't keep up, some data might be lost.    When the box is checked (the default), Smartcom alerts you to the 
possibility of lost data.    When it is unchecked, you won't be alerted, even when a data overrun occurs.

Display Phone Book on startup

If you want Smartcom to automatically display the phone book for telephone number selection on startup, check this 
box.    If not, leave the box unchecked.

Save peruse buffer

This option controls the saving of peruse buffer information to disk on exiting Smartcom.    Select:

· Always to always save the information on disk
· Never to always discard the information
· Ask to have Smartcom prompt you, each time you're exiting the program, whether you want to save the 

information.

If you save the contents of the peruse buffer, they are restored in the main communications window the next time 
you start Smartcom.

Note that when the peruse buffer fills up, the oldest information in the buffer is discarded to make room for the 
newest.

Font size

Font size changes the screen font point size for the document.    Select the size from the drop down listing.

Default colors

You can change screen colors for the communications document.    Select the Default colors arrow and drag it to 
display a box containing different background and foreground colors, and choose the combination you prefer.

Number of colors

Depending on the type of monitor you have, you can choose to display 8 or 16 colors.

Local character set

You can change the character set Smartcom displays on your screen and captures to disk files.    If you want to use 
the US 437 character set, darken that button.    To use Windows ANSI, darken that button.



SCOPE Scripts

With the SCOPE menu's Scripts command, you can Copy, Rename, or Delete a script.    To do so, select it on the 
list and then select the appropriate button.    You are prompted to supply the new name, name of the copy, or 
verification that you want to delete the script.



Keyboard

Smartcom provides numerous keyboard shortcuts that perform program actions. 

Select the Settings menu's Keyboard Map item.    All keyboard shortcuts are listed.    You can print them with the 

 button.



Untitled Document Restrictions

In an Untitled communications document (one that has not yet been saved to disk), you can't work with SCOPE 
scripts or buttons.    (You can use an existing button, but you can't define a new, blank one.)    This is because scripts 
and buttons have to be associated with a uniquely named communications document, and a document doesn't get a 
name until it is saved.

If you want to define a blank button or learn a script, click on  to file the communications document to disk, 
just as if you had selected the File menu's Save As command.



ASCII: American Standard Code for Information Interchange, a standard coding scheme in which seven-bit codes 
represent printable characters and control codes.    "Extended" ASCII includes graphics characters, characters used in 
different languages, and other special symbols.    Eight bits are required to encode extended ASCII characters.



Autotype Protocol: A protocol used for sending text files with the  (Autotype) Button.    Also called flow-
control protocol, since it paces the sending of data to ensure that the sender doesn't transmit information too fast for 
the receiver to keep up.    This type of protocol is different from an error-free file transfer protocol, which checks for 
and corrects transmission errors when sending files. 



Batch File: A Smartcom file that contains a list of file names to be transmitted using the ZMODEM file transfer 
protocol. 



Baud: In common usage, the speed at which data is transmitted, in bits per second (bps).    Technically, this is not 
exactly correct.    Baud actually refers to the modulation frequency at which data is encoded for transmission over 
the phone lines.    Depending on the encoding and data compression techniques, the actual amount of information 
transmitted can greatly exceed the baud rate.    For example, when modems connect using the CCITT V.22 bis 
standard, they encode 4 bits of data at 600 baud, for a throughput of 2400 bps.



Bits Per Character: The number of data bits used to encode each character of information.    This number does not 
include the bits used for parity or stop bits. 



Break: A break signal is a signal of a certain duration you can send to the remote system.    The break is interpreted 
by different remote systems in different ways.    Depending on the remote system, the break signal might be used as 
a command, for example, to:

· interrupt an operation in progress
· break a connection
· get the system's attention. 



Carriage Return: A character that forces the cursor to the leftmost position of the line.    Normally, a carriage return 
is matched with a line feed to advance the cursor to the next line. 



Carrier: Carrier is a signal used by two modems to negotiate and maintain a connection.    At the start of a 
connection, modems use carrier signals to negotiate the speed and type of connection to establish.    During the 
communication, the continuing presence of carrier is an indication that the connection is ongoing and should be 
maintained.    When the one modem's carrier disappears from the line, the other modem knows that its counterpart 
has hung up.



Character Format: Character (or data) format is a term used to described the way a computer constructs a character 
of information, called a byte.    A byte consists of character bits, one or two stop bits, and may use a parity bit.    
Character format should match that of the remote system. 



Character: A character is a unit of communication and is the equivalent to a single letter of the alphabet. 



Clipboard: The holding place in Windows that stores information, text or graphics, that you copy or cut.    The 
contents of the clipboard can be pasted into applications, including into the main communications window in 
Smartcom for Windows.    When pasted, the clipboard contents are sent to the remote system.    They can also be 
pasted into the Smartcom Editor and other Windows applications.



Communications document: Communications documents are collections of settings that tailor the program to 
accommodate unique remote systems you communicate with.    For each remote system you communicate with, you 
can create custom settings that tailor Smartcom to the system. 



Control Character (Control Code): A general term to describe any non-printing character in the ASCII standard.    
Carriage Return and Line Feed characters are control characters (Ctrl-M and Ctrl-J).



CPS: Characters per second: a measure of the speed at which information is transferred. 



DCE: Data Communications Equipment: a general term used to describe and communications device, such as a 
modem or ISDN adapter.    A DCE device is often connected to and controlled by a DTE device.



DCE Speed: The    speed at which two DCE devices are communicating, in bits per second.    Contrast with DTE 
Speed.    This illustrates DCE and DTE speeds:



DTE: Data Terminal Equipment is a common designation for computer equipment that connects to and, in many 
cases, controls communications equipment.    This includes computers, terminals, and printers.



DTE Speed: Used to describe the speed at which a modem communicates with the computer device to which it is 
attached.    When using an error-free connection, this speed usually exceeds the DCE Speed to allow data 
compression to work effectively.    This illustrates DCE and DTE speeds:



Emulation (Terminal Emulation): A process that enables your PC to respond as if it were a specific type of 
terminal.    Smartcom receives and interprets special codes, called emulator codes, and uses them to display 
characters correctly on your screen.    For example, special, non-displaying characters are sent to Smartcom from 
bulletin board systems that implement the ANSI terminal emulation method.    These codes can tell Smartcom to 
change colors, make characters blink, and perform other display operations.    Likewise, some of your keypresses, 
such as the arrow keys, need to be translated into codes the remote system understands as a command to move the 
cursor.    Different emulators use different codes for various purposes, and that is why it is desirable for you to select 
the terminal emulator best suited to the remote system.



File Transfer Protocol: A protocol used for sending or receiving files of any type with the  Send or 

 Receive Button.    Also called error-free protocol, since it makes sure that data is transmitted without errors.    
The sender performs calculations on sections of the file, called blocks, and sends the results along with the block.    
The receiver performs the same calculations, and, if results match, the block is without errors.    If errors are 
detected, the bad block can be discarded by the receiver and retransmitted.



Flow Control: A method by which communications programs pause and restart information transmissions so that 
the receiver can keep up with the sender, preventing loss of data.    In Xon/Xoff flow-control, Control-S (Xoff) 
pauses communications, and Control-Q (Xon) restarts.    This is the most common form of flow-control. 



Hardware Flow-Control: A method of pausing and restarting communications by changing signals on wires in the 
connecting cable.    To operate properly, the cable must be wired correctly and the devices must support hardware 
flow-control. 



Line Feed: A character that advances the cursor one line while maintaining its horizontal position.    Usually, a line 
feed is matched with a carriage return.    The carriage return/line feed pair advances the cursor to the first column of 
the next line.



Parity: An optional bit that can be included in a character of computer information.    The parity bit is used by some 
devices to check for errors when information is transferred from one location to another.



Peruse Buffer: The memory area (or allocation of disk space) that stores all the information you exchange with the 
remote system.    Scroll through peruse buffer contents using the scroll bar of the main Smartcom window. 



Protocol: A set of rules by which two computers exchange information.    There are two main types of protocol 
relevant to Smartcom settings: flow-control and error-free.    Flow-control manages the flow of information in such a 
way that the sender doesn't transmit information too fast for the receiver to keep up.    An error-free file transfer 
protocol oversees the transmission of computer files.



SCOPE: Simple Communications Programming Environment, the scripting language used by Smartcom.    SCOPE 
consists of commands that execute Smartcom operations. 



SCOPE script: A series of SCOPE commands automate communications tasks.



Start/Stop Flow Control: (Also called Xon/Xoff) is a method of pausing and restarting communications by 
transmitting Xon (Control-Q) and Xoff (Control-S) characters. 



Stop Bits: Bits used to mark the end of each character. 



Terminal: A screen and keyboard used to communicate with another computer. 



Transmission Speed: The speed at which two devices communicate and exchange data.    This is measured in bits 
per second (bps).    This term is often used interchangeably with baud and baud rate, but they are not really the same. 
Baud refers to the frequency of the modulation of signals on the line.    The method by which data is encoded and 
transmitted at a certain baud can increase the actual transmission speed.



Transparent Xon/Xoff Flow-Control: A method of flow-control supported by Smartcom and Hayes V-series 
modems.    This method uses Xon (Control-Q) and Xoff (Control-S) characters in a way that does not interfere with 
those characters in the data stream. 



Xon/Xoff Flow-Control: Another name for Start/Stop flow control: it uses a method of pausing and restarting 
communications by transmitting Xon (Control-Q) and Xoff (Control-S) characters. 



Smartcom and Script Startup Options

Smartcom provides a variety of program and script startup options that streamline the program execution process.    
The options let you use command line parameters and icon drag-and-drop techniques to customize how the program 
operates as you start it.

You can also use File Manager drag-and-drop techniques to start Smartcom using specific communications 
documents or scripts.

Command Line Options

When you double-click on a program icon to start the application, you are actually telling Windows to execute a 
command.    You can view the command associated with an icon by clicking on the icon, pulling down the Program 
Manager's File menu, and selecting Properties.

You can also start Windows and execute the program directly from the DOS prompt.    Precede the command line 
with the Windows startup command WIN.

For example, to launch Windows and Smartcom at the same time from the DOS prompt, you'd enter:

WIN SCWLE

You can also run a program at the Program Manager by pulling down the File menu and selecting Run.

Then enter the command line, for example:

SCWLE

Whichever method you use to start Smartcom with a command, you can specify additional parameters that 
customize how the program executes on startup.    They are included after the SCWLE command on the line.    The 
parameters are all optional.

The command line with all options is:

SCWLE -X (or -N) filename/scriptname

· -X runs Smartcom maximized, that is, as a full window.

· -N runs Smartcom minimized, that is, as an icon at the bottom of the Program Manager window.

You can use -X or -N, but not both at the same time.

· filename runs Smartcom using the communications document stored in the file filename.    The .SCW extension, 
normally a part of communications document filenames, need not be included as Smartcom assumes it.    
SCWLE BBS would start Smartcom and open a communications document stored in the file BBS.SCW.    You 
can also include, as part of the filename, a drive and directory path designation, for example, SCWLE C:
\SCWINLE\COM\BBS.

· If you use the filename option, you can also use the /scriptname option to specify a script, stored in the 
communications document, to automatically run when Smartcom starts.



Don't include any spaces between the filename and the slash nor between the slash and the scriptname.

If the communications document contains an automatic startup script (AUTOEXEC), and you specify a 
scriptname, the scriptname script runs instead of AUTOEXEC.

At the File Manager

In the File Manager, you can start Smartcom with these options:

· Double-click on the Smartcom program icon (or select it and use the File menu's Run command).

· Double-click on a communications document icon (or select it and use the File menu's Run command).    This 
starts Smartcom using the selected communications document.

· Click on and drag a communications document onto the Smartcom icon.    You can also drag one of the File 
Manager communications document icons onto either the File Manager Smartcom icon or onto a minimized icon 
of a running Smartcom program.    You can also drag the File Manager communications document icon into an 
open Smartcom Untitled window to open that document.







Settings and Online Techniques

These topics provide information about frequently used Smartcom features:

· Communications Documents and Settings
· Online Techniques
· Background Operations
· Getting Session Status



Main Buttons

Buttons at the bottom of the screen are standard to all documents and perform common operations.    Clicking on a 

button turns its feature on.    For example, click on the  button to start a connection.

    A gray frame around a button means it is not in use:

    A green frame means the button's feature is turned on.

When a button is turned on, clicking on it turns its feature off.    For example, clicking on the green phone button 
ends a connection.

You can modify the buttons and add your own custom buttons to use them to start a variety of Smartcom activities 
with the click of the mouse.

Click on a topic below for details about a specific icon.

Phone Icon

Printer Icon

Disk Capture Icon

Autotype File Icon

        Send File Icon  

Receive File Icon

Phone Book Icon



Phone    

Clicking the Phone button starts a connection.

When the Connection Menu is set to Connect Through Phone, Smartcom starts a modem connection.    It dials if the 
Connection menu is set for Originate, or waits for an incoming call if Answer is selected.

For Originate, clicking the Phone button displays a phone number verification box.    Verify the number to place the 
call.    If you use the Connection menu's Phone Number setting to specify a default phone number for a 
communications document, you can bypass the phone number verification step by double-clicking the Phone button. 
This action automatically dials the recorded number.

For Answer, Smartcom waits for an incoming call, and then answers it.    The number of rings it waits before 
answering is controlled through the Modem Settings screen. 

When the Connection Menu is set to Direct Connect, clicking the Phone Button starts a communication 
immediately via the communication port selected with the Connection menu's Choose Port option.    Direct 
Connect is the setting used when connecting two computers with cables. 



Printer 

Clicking the Printer button prints information you exchange with the remote system.

To print information as it arrives on the screen, click the button without any information selected.

To print information when it is already displayed on the screen, select what you want to print, and then click the 
Printer icon.

For details on selecting information, see the topic Online Techniques.



Disk Capture 

To capture information you exchange with a remote system, click the Disk Capture icon.    You're asked to specify 
the file name, including, if needed, disk and directory specifications, to store the text.    While the disk capture 
feature is on, information exchanged with the remote system is routed to the text file.    To stop capturing to the file, 
click the button again.

Selected text can be captured to disk.    Select the information, click the Disk Capture icon, and then specify the file 
name. 

For details on selecting information, see the topic Online Techniques.    You can also choose whether or not you want 
non-ASCII characters filtered out of files captured to disk with the Filter data captured to disk option.



Capturing to an Existing File

When you instruct Smartcom to capture information to a file that already exists (by specifying an existing file's 
name in the Capture to File dialog box), Smartcom asks if you want to:

·  the new information to the bottom of the existing file, adding to the file instead of replacing it.

·  the contents of the file with the new information you're capturing.

·  and go back to the previous step so you can specify a different file name or cancel the capture 
process.



Autotype File 

Use the Autotype button to transmit a text file to the remote system as if you were rapidly typing it.    Smartcom uses 
the currently selected Autotype Protocol to control the flow of data to the other computer.    You can select an 
autotype protocol, and choose whether or not you want non-ASCII characters filtered from autotyped files, with 
Autotype Protocol options.



Send File 

The Send button sends a file error-free using the current File Transfer Protocol.    This protocol is selected at the 
Settings menu.

On selecting Send File, you're asked to specify the file.    Some file transfer protocols support multiple file transfers, 
so you can select a number of file names using wildcard characters or a Smartcom feature that lets you build a list of 
files to transfer.

Some file transfer protocols require that the remote system explicitly set up to receive a file; others automatically 
start the other system receiving when the sender begins the transfer.

A file transfer protocol is like a language.    Both parties in the communication must use the same one.



Online Techniques

In the main communications window, you can work with information while or after it is received.    You can print 
text and graphics or capture them to a disk file.    These topics explain how to select and work with information in 
the main window:

· Capturing Information as Received
· Scrolling Back to Access Previously Received Information
· Capturing Information Already Received
· Mouse Selection Techniques
· Keyboard Selection Techniques
· Sending Clipboard Contents
· About the Peruse Buffer



Capturing Information as Received

To print or capture to disk information while it is being received, click on the (Printer) or 

 (Disk Capture) button.    If capturing to disk, you're presented with a window in which you can identify the 
disk, directory, and file name to receive the information.    You can capture to both destinations at once by clicking 
on both buttons.    Information is routed to the printer or file as it arrives on screen.    To stop the capture process, 
click on the button a second time.



Scrolling Back to Access Previously Received Information

When you've received more information than can be displayed in the window, you can scroll back to work with that 
previously received information.    The information is stored by the computer.    This storage space is called the 
peruse buffer.    (More about the peruse buffer at the bottom of this Help topic.)

To access stored information, use the scroll bar:

You can further customize the display by resizing the window and by repositioning or hiding the buttons.



Capturing Information Already Received

Click and drag across the information you want with the mouse, or hold down the Shift key while pressing an arrow 
key to highlight it.

Then select the printer or disk capture icon.    If capturing to a file, you're presented with a window in which you can 
identify the disk, directory, and file name to receive the information.



Mouse Selection Techniques

These mouse techniques select text in the main communications window:

To select: Do this with the mouse:
A word Double-click on the word.    

Hold down the mouse button 
on the second click and drag to 
select word-by-word.

A line Triple-click on the line.    Hold 
down the mouse button on the 
last click and drag to select 
line-by-line.

A word and 
automatically 
paste it into the 
on-line session

Control-click on the word.

After selecting a word or line, on the last click keep the mouse depressed and drag to select by the word (or line).    
You can also move the mouse to a new location, and combine Shift with a double mouse click to select all words 
between the prior insertion point and the new one, or triple click to select lines.



Keyboard Selection Techniques

These keystrokes move the cursor.    Holding down the Shift key while pressing any of these keys selects the text in 
between the starting point and destination.

These keys: Move the cursor:
Arrow keys One character right, left, up, or 

down
Ctrl-right/left 
arrow keys

One word right/left

Home To the beginning of the line
End To the end of the line
Ctrl-Home To the top of the peruse buffer
Ctrl-End To the bottom of the peruse 

buffer
PgUp One screen up
PgDn One screen down

Note: To view or print a complete list of keys that move the cursor and perform other peruse buffer actions, pull 
down the Settings menu and select Keyboard Preferences.



Edit Cut 

The Edit menu's Cut command erases a selection of information from the peruse buffer, copying it to the clipboard. 
The information can be pasted into other Windows applications such as Smartcom Editor.    If the information is text, 
it can be pasted into the session, when Smartcom autotypes it to the remote system using the current autotype 
protocol.    To paste the information, use the Edit menu's Paste command.



Edit Copy 

The Edit menu's Copy command copies a selection of information in the peruse buffer to the clipboard.    The 
information can be pasted into other Windows applications such as Smartcom Editor.    If the information is text, it 
can be pasted into the session, when Smartcom autotypes it to the remote system using the current autotype protocol. 
To paste the information, use the Edit menu's Paste command.



Edit Paste 

The Edit menu's Paste command transmits the contents of clipboard to the remote system.    The information must 
be text for this to work.

Information can be placed in the clipboard in other Windows applications, such as Smartcom Editor, or from the 
current session.    Use the Copy or Cut command in Smartcom to place the information in the clipboard.    Then 
select Paste.    Paste uses the current autotype protocol. 



Sending Clipboard Contents

If you've copied or cut text or graphics to the Windows clipboard, you can transmit the information to the remote 
system online by selecting Paste from the Edit menu.    The currently selected autotype protocol is used to transmit 
the text.



Sizing the Window

The main communications window can be resized like other Windows applications. Simply click the Restore button 
 in the upper right corner, or drag one of the window borders for the desired size.    The Restore button appears 

after the window has been maximized, using the Maximize button 

.

See also
Flip Buttons and Hide Buttons.



Background Operations

Smartcom is fully compatible with Windows, which permits it to conduct operations in background while you work 
with other applications.    These operations include SCOPE scripts, file transfers, and information captures to disk or 
the printer. 

Occasionally, applications running in the foreground use most of the computer's processing time.    This deprives the 
background program of computer processor resources.    In such a case, the background program can't run efficiently. 
If Smartcom is attempting a file transfer in background, and the foreground application uses a lot of the computer's 
resources, the transfer can proceed slowly.    You'll notice that Smartcom keeps trying to resend blocks, and a transfer 
can be abandoned if it takes too long or too many blocks have to be resent. 

Sometimes the foreground application does not appear to be requiring a lot of processor resources, but actually does. 
For example, recomputing a large spreadsheet is a task that requires little user interaction, but can require a lot of 
computational power.

If your background file transfers fail because of a timeout, or if blocks are often resent, consider these two solutions: 

· Run Smartcom as the foreground application, or
· Use a foreground application that requires less processing time. 

See also
"Setting Multitasking Options" in the Microsoft Windows User's Guide. 



Edit Menu

With the Edit menu you can

· Reverse text editing actions
· Access a temporary storage area called the clipboard to cut or copy text into it, paste information from it, or view 

its contents
· Locate specific text strings in the peruse buffer, and
· Quickly select all the contents of the buffer.    Information in the clipboard can be used in any Windows 

application. 

The clipboard can hold text or graphics.

Click on a menu item for information about it (keyboard: Tab and Enter):

Using the Clipboard During Communications

When viewing the main communications window, either text or graphics information can be stored in the clipboard. 
Simply select the information, and pick Copy from the Edit menu.    The information is stored in the clipboard, and 
you can Paste it into the session or into another application.    When pasted into the session, it is transmitted to the 
remote system using the current autotype protocol.



File Menu

The File Menu provides command options that work with communications documents.    It also lets you set print 
options and exit the program.

Click on a menu item for information about it (keyboard: Tab and Enter):



Connection Menu

The Connection Menu specifies the communication document's connection methods.    You can use a document to 
connect by modem to the phone lines, or set up a direct connection, by cable, for example, to another computer.    
When connecting by modem, you can instruct Smartcom to dial a specific number, or to answer an incoming call.

Click on a menu item for information about it (keyboard: Tab and Enter):



Edit Undo 

The Edit menu's Undo command reverses the last Cut or Delete of information from the peruse buffer.    Selecting 
Undo again reinstates the Cut or Delete.



Edit Delete 

The Edit menu's Delete command removes selected text from the peruse buffer without saving it to the clipboard.    
The last deletion can be reversed, however, with Undo.



Edit Select All 

The Edit menu's Select All command provides a convenient way to select the entire peruse buffer.



Edit Show Clipboard

The Edit menu's Show Clipboard command opens the Windows Clipboard Viewer. The Clipboard Viewer lets you 
view, save, and retrieve the contents of the Clipboard. 



Edit Find

The Edit menu's Find command locates text stored in the peruse buffer.    On selecting Find, type in the letter, word, 
or phrase to locate.    You can also use these options:

· Match whole word only searches for complete words only.

· Match case matches uppercase and lowercase letters exactly. 

· Wraparound search looks through the whole document.    Normally, the search ends when the text is found or 
the bottom of the document is reached (or the top for Up searches).    With Wraparound search selected, the 
search proceeds past the bottom or top, all the way around to the search starting point.

· A Direction, Up or Down,    for the search.    Down searches toward the bottom of the document.    Up searches 
backwards, toward the top.

Your choices for Find What, Direction, Case sensitive, and Wraparound are stored with each document.

You can look for the text again using Find Again.



Edit Find Again

Select the Edit menu's Find Again command to search for a second occurrence of text you used Find to look for.    
The Find What, Direction, Match whole word only, Match case, and Wraparound options used for the last 
search are used for Find Again.



File Exit 

The File menu's Exit command quits Smartcom and return to Windows.

Depending on what you've done during the session, Smartcom may suggest some actions you might want to take 
before exiting:

· You're asked if you want to save the contents of the peruse buffer.

· If you've made setting changes and haven't saved them in a document, you're asked if you want to save them

· If you've got a live modem connected, you're asked if you want to disconnect or cancel the Exit command.

If you want to skip the message asking you about saving the peruse buffer, you can do so with the Settings menu's 
Preferences option.    Change the Save peruse buffer setting from Ask to Never or Always.



File New 

Use the File menu's New command to open a new, untitled communications document.    The document's settings are 
standard ones that work with most remote systems. 

SCOPE scripts and button sets can't be used in an Untitled document.    To use them, first save the open Untitled 
document to disk under a new name.

If you find that you frequently create new documents, and are always having to change the same settings before 
saving them to disk, you can adjust the default settings of the Untitled document.    To do so, create a new document 
and save it under the name Untitled in the same directory as your other documents are stored.    From then on, 
selecting New opens the document containing your preferred settings.



File Open 

The File menu's Open command loads the settings of a titled communications document saved to disk.    The open 
document's name is displayed in the title bar.    If the document has the Auto-Connect option enabled, a connection is 
started automatically.



Open Dialog

When opening a communications document, Smartcom presents a list of file names that are documents stored to 
disk.    Ordinarily communications documents are stored with the file extension .SCW, but if you sometimes save 
them with a different extension, you can specify that in the File Name box.    Or use *.* to list all files.

Typically these files are stored in the Smartcom communications document directory.    If Smartcom is installed 
using the default suggestions, this will be the \SCWIN\COM directory of the drive on which the program is 
installed.    However, if you store communications document files in a different location, you can use the Directories 
box to move through your directories, and the Drive box to select disk drives.    For details on selecting file names, 
directories, and disks, see the topic Using Browse Screens. 

Use the  button to open the selected communications document.



File Page Setup 

The File menu's Page Setup command controls the appearance of printouts.

The top part of the screen controls the page layout for printed information:

Set the top, left, bottom, and right margins by changing the number of inches, or fractions thereof, to indent text.    
The Print region lists how many columns (characters) fit into your selected margins, and how many lines.

For orientation, select Portrait (upright) or Landscape.    Landscape orientation prints text across a page turned 

sideways, and selecting this changes the dialog box's representation to show you this: .

The bottom part of the box controls other aspects of the printout:

For Font Size, select the point size for characters.    Use printer font instructs Smartcom to use the default font for the 
printer currently selected under Windows.    (Printer drivers in Windows normally have a default font for use with 
any application that doesn't specify a font when printing text.)    Using the default printer font typically speeds up the 
printing process.

If your printer can print Color or Grayscales, you can select that radio button.

Form feed characters sometimes instruct a printer to start a new page.    If you want form feed characters to start new 
pages, darken the Ejecting Page button.    Sometimes, however, you'll print information you captured to disk or 
want to autotype, and the information contains form feed characters that you don't want to start new pages.    When 
this is the case, darken Showing control character. 



File Save 

If you change any settings for a communications document, you can select Save on the File menu to store the 
changes to the disk.    If it is a document that has already been saved under a unique name, the changes are simply 
stored to disk.

If you are saving changes made to a new Untitled document, you are prompted to supply the document a name by 
which it will be stored, and can specify other options as for Save As.

If you make changes to a new, Untitled document, and don't save the changes, they remain in effect only while the 
document is open.



Phone Number

The Connection menu's Phone Number selection specifies the phone number to dial when you click .    You 
can also single-click on 

 to display the Phone Number entry area.    This number is dialed when the Connection menu is set to Connect 
Through Phone and Originate.

The Phone Number can contain up to 76 characters (unless you have the Use reduced command set option selected 
in Modem Settings, in which case the limit is 38 characters). 

In addition to numeric characters, Smartcom can dial "customized" alphabetic phone numbers. Just enclose 
alphabetic characters in quotation marks, and they will be translated into the proper numeric equivalents. For 
example, you can enter a Phone Number as 800-"US HAYES" to dial 800-874-2937.

You can also enter a Phone Number by clicking once on and typing the number in when prompted.

Once you've recorded a phone number for your document, you can bypass the Phone Number dialog box by double-

clicking on  to begin a connection.

Once you've used the  button to create a list of phone numbers for this communications document, you can 
use 

 button to access the drop down list of phone numbers, and select one from it.



Connection Direct Connect

The Connection menu's Direct Connect option is used when you're connecting without a modem, such as when 
connecting to another computer by a cable.    The Direct Connect command immediately starts a session on the 
selected communications port without issuing any modem commands.



Connection Answer 

The Connection menu's Answer setting specifies that a modem connection is initiated by answering the phone when 

 is clicked.    After clicking on the button, Smartcom sets up the modem and waits for an incoming call.

The call is answered after the number of rings specified by the Answer after € rings option in the Modem Settings 
dialog box.

Answer is selectable only when Connect Through Phone is set on the Connection menu.



Connection Auto-Connect 

You can set up a communications document to automatically start a connection when you open the document.    To 
do so, select the Connection menu's Auto-Connect option.    Use the File menu's Save or Save As command to 
record the setting change to disk.    The next time you open the document, a connection is begun using the 

document's settings, just as if you'd clicked on .



Select Modem & Settings

At the Select Modem & Settings dialog box (selected with the Settings menu's Modem option) you can pick the 
kind of modem you have.    On the left, select the Vendor (brand name) of the modem.    On the right, select the 
specific model.    Click OK to use the selected kind of modem.

You can also further customize your settings with the Settings and Advanced buttons.

If using an ISDN device, select ISDN from the list.    To customize communication settings, click the Settings 
button.    To customize ISDN particulars, click on Advanced.



Modem Settings

Although it is seldom necessary to adjust Modem Settings, you can customize modem operation with them.    By 
selecting Modem at the Settings menu, you can fine tune such aspects of the modem as its speaker volume and the 
ring on which it answers a call.    You can also issue special modem commands if you want to include some that 
Smartcom doesn't use.

Modem settings don't affect Direct Connect communications since they don't involve a modem.

These are the aspects you can fine tune after selecting Modem at the Settings menu:

Answer after   ð€  €   ring(s).  
Pause   ð€  €   seconds between retries  
Touch-tone delay  ð€     €   milliseconds.  
Assume dial tone after   ð€  €   second(s).  
Wait up to   ð€  €   seconds for carrier  
Carrier sustained for   ð€  €   deciseconds is recognized,  
Carrier lost for   ð€  €   deciseconds is disconnected.  
Show modem commands
Use reduced command set
Reset modem before use
Supports split-speed (V.23)
Speaker setting/volume
Monitor call for dial tone/busy
Advanced settings
Setup strings
Maximum port speed to modem
Always use this speed



Answer after € ring(s)

Selecting Modem at the Settings menu lets you access this setting and specify how many times the phone rings 
before the modem answers.

Setting the number of rings higher gives you a chance to answer manually when your line is for voice calls as well 
as data calls.    It can also be used to provide the originating side a better opportunity to recognize the ring tone when 
its recognition is a problem.



If no carrier, redial € time(s)

When the remote modem's carrier signal disappears from the line, your modem assumes the connection broken and 
hangs up.    Smartcom can be set up to automatically redial the remote modem when a connection is lost this way.

With the Modem selection at the Settings menu, you can access the If no carrier, redial € time(s) setting, and 
specify how many times to redial after a failed or broken connection.    You can also specify how long Smartcom 
pauses between retry attempts with the Pause   €   seconds between retries   setting.



Pause € seconds between retries

When the carrier signal of the other modem is lost, your modem assumes a broken connection and hangs up.    If 
you've set Smartcom to automatically redial a certain number of times after a broken connection, this setting    
selectable with the Settings menu's Modem command    specifies how many seconds to wait between each retry.

You can enable redialing on carrier loss with the If no carrier, redial   €   times   on the same settings screen.



Touch-tone delay € milliseconds

This defines the time lapse between the dialing of each digit of phone numbers.    Occasionally you may need to 
increase this delay for slower phone systems.    Access this setting by selecting Modem at the Settings menu.



Assume dial tone after € second(s)

This setting specifies how long the modem waits for a dial tone before dialing.    Occasionally you may need to 
increase this delay for slower phone systems.    Access this setting by selecting Modem at the Settings menu.



Wait up to € seconds for carrier

When beginning a connection, a modem waits for the other modem to send a signal called the carrier.    This alerts a 
modem to the presence of another modem on the line, indicating a data connection.    If the carrier signal isn't 
detected, the modem abandons the connection attempt and hangs up.

You can change the amount of time your modem waits for the other modem's carrier signal with this setting.    A 
typical adjustment is to increase the waiting period to allow your modem additional time to recognize a carrier 
signal of a type that may be difficult for your modem to detect.

Access this setting by selecting Modem at the Settings menu.



Carrier sustained for € deciseconds is recognized

Carrier is a term that describes the signal modems apply to the phone line.    By detecting the presence of a carrier 
signal generated by the other modem, a modem knows there is a data connection.    The standard setting is 
appropriate for normal connections.

However, you may wish to decrease the amount of time for a noisy phone line, as static on the line can interrupt the 
carrier signal and cause a connection or connection attempt to be abandoned.

Occasionally a modem will misinterpret a dial tone, busy signal, or ring signal as a carrier signal.    In such a case, 
you may wish to increase the setting, giving the modem additional time to distinguish a true carrier signal from other 
tones.

Access this setting by selecting Modem at the Settings menu.



Carrier lost for € deciseconds is disconnected

Carrier is a term that describes the signal modems apply to the phone line.    During a connection, the presence of the 
other modem's carrier signal lets your modem know that the connection is ongoing.    When carrier is lost for a time, 
your modem drops the connection, assuming the other side has hung up.

On a noisy phone line, static may cause carrier to be interrupted and your modem may interpret this as a hangup by 
that party, even though it has not hung up.    If your modem repeatedly hangs up on a remote modem during 
connections to it, this could be and indication of a noisy line condition, and this setting might require an upward 
adjustment.

Access this setting by selecting Modem at the Settings menu.



Show modem commands

Checking this box lets you view the setup and dialing commands Smartcom sends to the modem during the 
connection process.

Access this setting by selecting Modem at the Settings menu.



Use reduced command set

This option is provided to allow Smartcom to successfully control modems that do not implement all the commands 
a Hayes modem does.    If you have a non-Hayes modem, and you experience difficulties with Smartcom 
recognizing or using your modem, you might solve the problem by checking the Use reduced command set option. 
Access this setting by selecting Modem at the Settings menu.

When this option is used, Smartcom does not query the modem for its identity (a code that specifies its type and 
therefore its capabilities and features).    For this reason, you can't use the Maximum setting for Transmission speed 
(also accessed by selecting the Modem at the Settings menu).    In addition, the Phone number is limited to 38 
characters, and the error correction and data compression settings are disabled. 



Reset modem before use

If you choose this option, Smartcom sends an ATZ (reset) command before dialing to restore the modem's stored 
profile settings.    Dialing is faster if you leave this option unchecked.    Select it only if Smartcom has trouble 
controlling the modem after you have used another communications program. 

Access this setting by selecting Modem at the Settings menu.



Supports split-speed (V.23)

If your modem supports split-speed (V.23), and this is a feature you'll be using, check this box.    This permits 
Smartcom to take advantage of the modem's ability to communicate (principally with information services) at split-
speeds of 75/1200 and 1200/75.



Speaker setting/volume

Set the speaker according to your preference.    The speaker can be set to be Always on, Always off, or On unless 
dialing.    On until carrier means you hear the connection process, including the dialing and the carrier negotiation, 
and then the speaker turns off.    Set the volume to Low, Medium, or High.    The volume settings have no effect on 
Smartmodems with back-panel volume knobs.

Access these settings by selecting Modem at the Settings menu.



Monitor call for dial tone/busy

Ordinarily you'll want your modem to monitor for the presence of a dial tone and busy signal during the course of a 
connection attempt.    That way, when no dial tone is present, or a busy signal is detected, the modem can 
immediately abandon the connection attempt.

However, on some telephone systems, the modem may misinterpret signals.    If this occurs, uncheck the appropriate 
box.

Access this option by selecting Modem at the Settings menu.



Advanced Settings

Advanced settings control error-correcting modems.    These settings are ignored if you are using a product that 
Smartcom doesn't identify as error-correcting.    Access these settings by selecting Modem at the Settings menu, and 

clicking the  button.

Error-control

This setting determines how an error-correcting modem establishes a connection:

· No, async only instructs the modem not to use any form of error control for the connection. 

· Yes, if possible instructs the modem to negotiate with the remote modem to use error-control.    If the remote 
modem can't use a form of error-control supported by your modem, a regular connection is established. 

· Yes, or hang up instructs the modem to negotiate with the remote modem to use only an error-control 
connection.    If an error-control connection can't be established, your modem hangs up. 

Feature Negotiation

This setting determines the type of negotiation your modem tries to perform with the remote modem.    If you are 
communicating with a non-Hayes V. 42 modem and cannot establish a V. 42 connection, set this to V. 42 only and 
retry the call.    If you still have problems, try None. 

Data Compression

If Feature Negotiation is set to None, you have to control compression manually.    When Feature Negotiation is 
None:

· Uncheck the box if you don't want to use data compression, for example, when transferring files that are already 
compressed

· Check the box if you want to use data compression

Error-control Protocol

When you select error-control protocols with the check boxes, your modem negotiates with the remote modem to 
attempt to use one protocol, then another, down the line, trying to use the best first.

If you have a non-Hayes error-control modem and can't establish an error-control link, set Feature Negotiation to 
None and deselect all protocol boxes except the one supported by the remote modem. 



Advanced Settings

With the Advanced Settings dialog, you can specify different operating modes for the selected modem.    Specifying 
a particular mode permits Smartcom to more efficiently monitor and control the modem when it is being used for a 
specific purpose.    If you know the most suitable operating environment for the particular type of information 
transfer you want your modem to perform, you can select it here.

Some modems can use the split-speed V.23 protocol for use with some information services that implement it.    To 
use V.23, select that operating mode from the drop-down list.



Setup strings

Smartcom sets up the modem by issuing standard Hayes AT commands to it.    These commands set up operating 
parameters and select which features the modem will use during communications.    In some instances, you might 
want to issue special setup commands to your modem.    Two example cases in which this might be desired are 
when:

· You don't have a Hayes modem and it requires special setup strings

· You want to issue special setup commands to the modem and those commands are not selectable with the 
Modem Settings dialog. 

You can specify custom setup strings by selecting Modem at the Settings menu, and picking the  
button.

Five different strings boxes are provided, each of which can contain up to 40 characters. Two strings are for modem 
setup, and these are always sent before dialing or answering. 

Additionally, a string is provided for those commands which you want sent only before dialing. This string is sent 
after the two Setup Strings. 

The fourth string is sent only when answering.    It also follows the two Setup strings. 

The fifth string is sent after Smartcom hangs up.    You can use it to reset your modem or restore specific settings 
Smartcom might have changed. 

Note that Smartcom prefaces each command with "AT" so your strings shouldn't include it. 



Maximum port speed to modem

The Maximum port speed to modem on the Modem Settings dialog box, accessed from the Settings menu, lets 
you limit the serial port speed of your computer.    This transmission rate between your computer and your modem is 
known as the DTE speed.    This speed may be different from the speed at which your modem is communicating 
with the remote modem (the DCE speed).    In Smartcom, the DCE speed is set through the Transmission Speed 
setting.

For error-correcting modems with data compression, Smartcom automatically sets the port speed.    This speed is 
usually much higher than the speed at which the modems communicate. This can result in dramatically increased 
performance. For example, an error-correcting 2400 modem with data compression can perform almost as fast as a 
9600 modem, so the DTE speed is set much higher than the DCE speed.

Typically, modem control logic in Smartcom dynamically selects a port speed that provides optimal performance.    
However, there are two instances in which you might need to limit the port speed to a specific rate:

· When you're communicating in a local area network environment that does not permit dynamic speed changes, or 
limits the maximum allowable speed

· When your computer can't keep up with very fast modem connections

In either case, select the maximum allowable port speed.    In the case of a network that does not allow dynamic 
speed changes, also turn on Ignore CONNECT result code.    The port speed then remains unchanged from the 
maximum port speed you specify.

In a case in which your standalone computer (not on a network) can't keep up with a fast modem connection, you 
can also try experimenting with flow control settings to see if they can fix the problem.

See also
Advanced settings.



Terminal Settings

Terminal settings customize how online information is displayed on the screen and how the keyboard produces 
characters.    Change terminal settings if:

· You need to use a different terminal emulator
· You can't see characters you type
· The Return key doesn't work properly. 

You can adjust the way Smartcom displays information and interacts via the keyboard with the remote system with 
these settings:

Allow Extended 
ASCII

Permits use of special characters

Autowrap at 
maximum line length

Lets you automatically wrap 
words to the next line when lines 
exceed your specified maximum 
length

Backspace character Sets the keystroke that sends a 
backspace

Break signal length Sets the length of a break signal

Display incoming 
data with line feeds

Determines whether returns force 
new lines

Emulator Picks the terminal emulation 
method for the session

Filter data captured 
to disk

Enables the filtering out of non-
ASCII characters when disk 
capturing

Local character echo Sets whether characters you type 
are echoed to your screen by 
Smartcom

Maximum line 
length is   €   characters   

Sets the maximum length of lines 
in the peruse buffer

Send line feed with 
each Return

Specifies whether you send a new 
line character with each carriage 
return



In addition, with the  button, you can specify the greeting Smartcom automatically sends to the 
calling system when you answer.



Autowrap at maximum line length

This setting works in combination with the Maximum line length is   €   characters  .    It applies to all the information 
you exchange with a remote system.

Sometimes lines of information you exchange with a remote system will exceed the maximum line length.    This 
occurs when no carriage return is inserted to start a new line.    If this happens, Smartcom will automatically wrap 
text to the next line for you if you turn on the Autowrap at maximum line length option.

If you turn this option off, characters past the maximum line length are discarded.

In almost all cases, you'll want to keep this option turned on.



Local Character Echo

Typically the characters displayed on your screen have been echoed back from the remote system.    Some remote 
systems don't do this, however, in which case characters you type won't be displayed at all.    When this occurs, turn 
this option on to tell Smartcom to display the characters you type directly on your screen.

If this option is selected and the remote system is echoing characters, you'll see double characters, and should turn 
this option off.

At the Settings menu, select Terminal to access this option.



Allow extended ASCII characters

This Settings menu's Terminal option permits the exchange of characters not part of the standard set of ASCII 0-
127.    The standard ASCII set consists of letters, numbers, punctuation, and some standard control codes used by 
computers for various purposes.    Normally Smartcom converts extended ASCII characters into standard ASCII 
characters (by stripping one of the bits, called the "high bit," from characters).    Allowing extended ASCII permits 
use of an additional set of characters, consisting of international characters, line drawing characters, and other 
special symbols.

You can employ this option only when using eight bits per character.    This is because it takes eight bits to generate 
the extended ASCII characters. 

See also
Speed & Format Settings.



Backspace Key

This option controls how Smartcom generates the backspace character. 

Ordinarily, you'll want the backspace key to back up one column to delete the previous character.    If the backspace 
key doesn't work this way, try reversing the Backspace Key setting to fix the problem.

For most systems, a backspace is generated by sending ASCII decimal value 8, and Delete is produced by sending 
ASCII decimal value 127.    Some DEC systems use Delete for the Backspace function.

At the Settings menu, select Terminal to access this option.



Filter Data Captured to Disk

Smartcom removes non-printing control characters other than Tabs and returns from data captured to a disk file. To 
make Smartcom capture data exactly as it is received, deselect Filter data captured to disk.    To filter out non-
printing characters, check the box.

At the Settings menu, select Terminal to access this option.



Sustain break signal for € deciseconds

This setting, accessed with the Settings menu's Terminal option, specifies the duration, in hundredths of a second, 
of the break signal.    The break signal is used by remote systems for various purposes.    Depending on the remote 
system, the break signal might be used, for example, to:

· interrupt an operation in progress
· break a connection
· get the system's attention. 

If the remote system is supposed to respond to a break signal in a certain way but doesn't, try increasing this value.    
To send a break signal with Smartcom, select the Special menu's Send break option.



Answer Message

You can use the Settings menu's Answer Message option to specify a message to be sent to the remote system when 
Smartcom answers a call.    From the Settings menu, select Terminal, and then Answer Message...

Enter a message to send to the calling computer system, and click .



Protocol Settings for the Normal Protocol

The Protocol Settings box for the Normal autotype protocol -- accessed by selecting Autotype Protocol from the 

Settings menu, darkening Normal, and clicking the  button -- allows you to introduce delays in the 
transmission of Autotyped text.    This is useful when the remote system is not keeping up with the processing of 
characters it receives when Smartcom is autotyping the text file.

Using fixed time delays is the least efficient way to slow down autotyping, and therefore is the last method to try.    
But it is also virtually guaranteed to work, because you are manually slowing down the autotyping rate.

Usually you only need to slow down autotyping with these delay methods when all four of these conditions are true:

· The remote system can't keep up and therefore loses characters, and
· Send Lines isn't an appropriate autotype protocol for the remote system, and
· You can't use the Await Character Echo autotype protocol, because the remote system isn't echoing characters, 

and
· The selected communications document's flow-control method (chosen at the Settings menu by selecting Speed 

& Format) isn't preventing character loss

Typically, you should try to fix a problem with the remote system keeping up with your autotyping by first 
introducing only a very small line delay.    This is almost always effective.    To do so, click on the Delay € 
deciseconds for each line, and enter a small delay time, in tenths of a second.    Smartcom delays that long between 
sending each line of autotyped text.

If necessary, for very slow systems, you can instead introduce a character delay with the Limit data to € characters 
per second.    Smartcom delays the specified length of time between sending each character.    When calculating this 
delay, note that a character usually consists of 10 bits, so the character limit should be higher than one-tenth of your 
transmission speed to be effective.    For example, to reduce the transmission rate by half, divide by 20.    At 2400 
baud, you'd Limit data to [    120] characters per second, and at 9600, to 480, to cut the data rate for autotyping to 
half of the normal speed.

For extremely slow remote systems, you can introduce both a line delay and limit the characters per second.



Protocol Settings for the Await Character Echo Protocol

You can fine tune the way the Await Character Echo autotype protocol works with Protocol Settings.    The settings 
are accessed by selecting Autotype Protocol from the Settings menu, darkening Await Character Echo, and 

clicking the  button.

Wait up to € seconds for the character echo

While autotyping using the Await Character Echo protocol, Smartcom waits for the remote system to echo back a 
character as acknowledgment that it is ready for the next.    Smartcom waits this length of time for that echo, and, if 
it has not been received by then, presumes the character lost in transit and continues with the next character anyway. 
If the remote system is very slow and does not receive all the characters you autotype, you can set this value higher.

Send up to € characters before waiting

Autotyping with the Await Character Echo protocol is speeded up if you let Smartcom send ahead, that is, send 2 or 
3 characters before waiting for a character echo.    However, if the remote system is very slow, you may need to set 
the value lower, to 1 or 2.    If the remote system is quick and seldom loses characters, you can speed up autotyping 
further by setting the value to up to 9.



ZMODEM

ZMODEM is a very efficient and popular file transfer protocol.    It allows group file transfers and provides for 
recovery from lost connections.    If a transfer is interrupted because a connection was broken, on re-connection you 
can restart the transfer.    If the remote system supports recovery, the transfer is restarted at the interruption point 
instead of at the beginning, saving online time.

Because of its efficiency and versatility, ZMODEM is the standard protocol selection, and is the best choice for file 
transfers with remote systems that also implement the protocol.

With the Auto-receive option checked, when the remote system initiates a file send to your system, Smartcom 
automatically begins receiving without your having to do anything.    Uncheck the box if you want to disable this 
feature.    If the remote system also supports Auto-receive, when you begin sending, the other system will 
automatically start receiving.

When sending, select the disk and directory, as needed, and then pick out the files you want to send.    To send 
groups of files, use the DOS wildcard characters ? and *, or selectively pick a file or files from different directories, 
and build a list of files to send, in the Send File dialog box.

When you're sending files and the process is interrupted, you can resume the transfer at the point of interruption by 

sending a Smartcom Batch file (which will have the .SCB extension).    You'll use the  button to use this 
batch file for the transmission resumption.

You can fine tune the way the protocol works with the Protocol Settings button.



Send File Name

On using the  Send File button to transmit a file error-free to the remote system, you're presented with a dialog 
box in which you specify the file to be sent.    The File Name box contains *.* so that all files in the current directory 
can be displayed for selection.    However, you must specify a valid file name; wild card characters can't be used.    
Because you're using an error-free protocol, you can send files of any type, so the List Files of Type box will permit 
selection of All Files (*.*)

Use the Directories box to move through your directories, and the Drive box to select disk drives.    For details on 
selecting file names, directories, and disks, see the topic Using Browse Screens. 

You can use the Protocol drop down box to change from the current communications document's file transfer 
protocol to another.

When the file name, directory, disk, and protocol specifications are correct, use the  button to send the 
file.



Save List

If you build a list of files to transmit to a remote system, you can save the list for later use with the  
button.    The next time you want to send the files, use the 

 button.

Smartcom suggests you use the .SCB file name extension for your saved batch file, but you can enter any valid file 
name you like.

You can use the Directories box to move through your directories, and the Drive box to select disk drives.    For 
details on selecting file names, directories, and disks, see the topic Using Browse Screens. 



Protocol Settings

With the  button of the File Transfer box, you can fine tune the way the protocol works.

Wait up to € seconds before retry is the time to wait for an acknowledgment, from the receiver, that a block of 
data was received without error.    If Smartcom receives no acknowledgment within the specified time, it retries the 
block.    You may want to increase the wait time if the other computer is slow or when you are communicating over a 
long distance. 

Retry errors € times determines how many times Smartcom retries sending the same block before canceling the 
transfer.    If the phone connection is bad, you may want to increase this value. 



ZMODEM Protocol Settings

With the  button of the ZMODEM File Transfer box, you can fine tune the way the protocol works.

File Overwrite Options

You can specify what should occur during a ZMODEM transfer if the receiver already has a file with the same name 
as the one being sent.    To do so, use the drop down list for When sending, overwrite existing file if.

To specify what should happen to a file on your disk when the remote system sends one with the same name, pull 
down When receiving, overwrite existing file if.

For details on these options, see the topic ZMODEM File Overwrite Options.

Regardless of your ZMODEM overwrite selections, the receiver's choice always takes precedence.    If you choose 
not to have your files replaced by files sent to you (with Never overwrite (skip transfer)), they are never 
overwritten.    If the remote system's ZMODEM implementation allows selection of overwrite options, you won't be 
able to overwrite files when forbidden by that system's settings.

Resume interrupted transfers

A file transfer can be interrupted by user cancellation, error, or disconnection.    If a transfer is interrupted, you can 
later resume it if Resume interrupted transfers is checked during transfers.    If the sender transfers the file again to 
the same directory, the transfer resumes at the point of interruption.    The remote system must also support this 
feature for it to work.

Escape control characters

"Escaping" control characters means that control characters are not transmitted.    Instead, they are encoded as two 
other characters, then decoded by the receiver back into the original, intended control codes that were in the file.    
ZMODEM normally escapes a few control characters, (including Ctrl-P, Ctrl-Q, and Ctrl-S), but not all.    Checking 
this box slows down transfers because two characters are sent instead of one, but it is sometimes necessary to do so 
when transmitting across a network that does not pass all control characters.

When this option is on, all characters in the range of Control-@ (ASCII 0) to Control-_ (ASCII 31) are escaped. 

Skip if no local file

This option is useful when using ZMODEM exclusively to update existing files with new versions.    Checking the 
box instructs the receiver to skip, or the sender not to send, any file not already present on the receiver's system.    
Either the sender or the receiver can request this action.    This option is especially useful with transfers involving 
multiple files.

Use full pathname

This option is useful when the two parties engaged in the transfer want the sender to specify the directories into 
which the files should be stored on the receiver's disk.    When you check this option, it requests the sender to 
provide the directory (but not disk drive) specification.    If the option is enabled on both systems, the files are 
received into the designated directories.    If the path information from the sender includes directories not already on 
the receiver's disk, the directories are automatically created.

Window size

A window is an amount of data, in transit from sender to receiver, that has not yet been processed and acknowledged 



by the receiver.    Normally, the window size in ZMODEM transfers is Unlimited, meaning that ZMODEM never 
stops to wait for an acknowledgment from the receiver. 

If the remote system cannot accept data fast enough to maintain an unlimited window, you might experience 
frequent retransmissions of blocks or slow error recovery.    In such cases, you may want to experiment with the 
window size setting to determine the optimal choice.    Note that limiting the window size unnecessarily may result 
in slower transfers. 

Packet size

The Packet size setting specifies the amount of data placed in each block, or packet, sent to the remote system.    
Larger packets result in faster transfers, but can slow error recovery since a retransmissions will involve larger 
packets.    To select the best packet size, you should consider the transmission speed (baud).    High transmission 
speeds can retransmit large packets swiftly.    Smartcom features Automatic packet size selection, the standard 
setting, which usually results in the best performance.

Wait up to € seconds before retry is the time to wait for an acknowledgment, from the receiver, that a block of 
data was received without error.    If Smartcom receives no acknowledgment within the specified time, it retries the 
block.    You may want to increase the wait time if the other computer is slow or when you are communicating over a 
long distance. 

Retry errors € times determines how many times Smartcom retries sending the same block before canceling the 
transfer.    If the phone connection is bad, you may need to increase this value. 



ZMODEM Overwrite File Options

These are the selections available for When sending, overwrite existing file if:

· Different size or date: If the size or date of the file is different, the remote system's file of the same name is 
replaced by the one you're sending.    Use this to update file if your version is in any way different.

· Sender's file is newer: If your file has a later date, a remote system file of the same name is replaced.    Use this 
to update files.

· Sender's file is newer or longer: If your file has a later date or is bigger, a remote system file of the same name 
is replaced.    Use this to update files when you sometimes perform transfers more often than once a day.

· Always overwrite: Any file of the same name is replaced by the one you send.    Use this to update remote 
system files unconditionally.

· Never overwrite (skip transfer): This option ensures that remote system files are never replaced by files you 
send.    When sending a single file, the transfer stops.    When sending a group of files, files of the same name are 
skipped, but others in the group are transferred.

You can make the same kinds of conditional specifications when you're receiving with the When receiving, 
overwrite existing file if:

· Sender request: Means you will permit the remote system to overwrite your files with files it sends based on its 
When sending settings.    Use this setting when you want the remote system to be in complete control of 
replacing your files.

· Different size or date: If the size or date of the file is different, your file of the same name is replaced by the one 
you're receiving.    Use this to update your files with remote system files if they are in any way different from 
your own.

· Sender's file is newer: If the file you're receiving has a later date than one on your disk, the one on disk is 
replaced by the newer version.    Use this to update your files.

· Sender's file is newer or longer: If the file you're receiving has a later date or is bigger than one on your disk, 
your file is replaced.    Use this to update files when you sometimes perform transfers more often than once a day.

· Always overwrite: Any file on your disk is replaced if the one sent has the same name.    Use this to 
unconditionally update your files with the remote system's files.

· Never overwrite (skip transfer): This option ensures that your files are never replaced by files you receive.    
When receiving a single file, the transfer stops.    When receiving a group of files, files of the same name are 
skipped, but others in the group are transferred.

When used with multiple files, these options let you selectively update files with transfers.    For example, you can 
use the options to update only files that have changed since the last transfer.    You can combine these options with 
the Skip if no local file option described below.

Note: If the remote system's receiver does not implement ZMODEM's optional file management features, it may 
ignore attempts from Smartcom to use them.    When Smartcom is the receiver, overwrite options are used regardless 
of the remote system. 

Skip if no local file



This option is useful when using ZMODEM exclusively to update existing files with new versions.    Checking the 
box instructs the receiver to skip, or the sender not to send, any file not already present on the receiver's system.    
Either the sender or the receiver can request this action.    This option is especially useful when used with transfers 
involving multiple files.



Print List

After selecting Keyboard Preferences from the Settings menu, you can print a list of all the document's current 

keyboard assignments.    Click on the  button. 



Status Box Options

On selecting Preferences at the Settings menu, you can use the Preferences window's  button to tailor 
the status box display for the current communications document to your tastes.

Darken the appropriate buttons to select which information is displayed first, second, and third on the status line.

You can choose whether or not you want seconds displayed in time readouts by checking or unchecking the Show 
seconds in the time options option.

If you choose to display cumulative connect time for the communications document, from time to time you'll want 

to use the  button to reset the total connect time for all your communications sessions back to 
zero.



SCOPE Run / Stop Script

Run Script at the SCOPE menu runs a script.    Select a script associated with this communications document from 
the list, and then select Run.    While a script is running, this menu item changes to Stop Script, which lets you halt 
script execution. 



Run Script Dialog

Select the script you want to run now.    If there are no scripts associated with the currently opened communications 

document, the list is empty.    If there are scripts, highlight the one to run and use the  button to execute the 
script.

If you need to cancel the operation, click  or press Esc.



Hide/Show Buttons

To hide the buttons, select the Special menu's Hide Buttons command.    When buttons are hidden, the menu 
selection turns to Show Buttons.    Select Show Buttons to redisplay them.    You can also move the button display 
with Flip Buttons.



Flip Buttons

The Special menu's Flip Buttons command changes the Buttons from a horizontal arrangement to a vertical one. 
Flip Buttons again to change them back. Use this feature to achieve the best viewing arrangement. 

When buttons are flipped, they appear vertically to the right of the scroll bar:



Edit Buttons

To change a button's name, definition, or icon, or to clear (delete) a button, hold down the control key while clicking 
on the button.    You can also create a new button by Control-clicking on a blank button.

Another way to define buttons is select the Edit Buttons command from the Special menu.    This displays the Edit 
Buttons dialog, where you select the button to be edited.    Select an existing one to edit it, or one labeled (blank) to 

create a new one.    Then use the  button.

Whether you use the Control-mouse click method or the menus to select a button, the Define Buttons dialog is now 
displayed.    That box is where you define the button's action.



Edit Buttons Dialog

To edit an existing button, highlight it in this dialog box and use the  button.    To define a new button, 
highlight one listed as (blank), and then 

.    In either case, you're presented with the Define Buttons dialog box, where you can redefine the existing 
button or define the new one.



Define Buttons

When defining a new (or redefining and existing) button, you can select an icon for it, check the button if you want a 
Button title, and specify the title in the text box.    You can use the scroll bar to access additional icons.

Use the drop down list box at the right of the Define Button box to define the type of action clicking the button will 
perform. 

· Button Set lets you assign defined button sets to one button.    Click on the button to display the set.    For 
example, you could define a More Buttons button, so that clicking on it displays the extra set.

· Edit Action assigns a peruse buffer cursor movement or selection action to the button.    Clicking on the button 
moves to or selects information displayed in the main communications window.

· Keyboard Macro assigns a defined macro to the button.    The selected macro is replayed when the button is 
clicked.

· Program Action assigns a pre-defined program operation to the button.

· Run Application assigns a program to the button.    Clicking on the button runs the application in foreground.    
For example, you might assign the Windows calculator to a button by specifying C:\WINDOWS\CALC.EXE.    

Or you can use the  button to look through drives and directories of application files.

· SCOPE Script lets you choose a script to be run when the button is selected

· Terminal Function performs an action defined for the currently selected terminal emulator.    For example, an 
emulator function might send a special character or set of characters that are interpreted by the remote computer 
as a command to do something.    See the Smartcom Communications Reference manual for a comprehensive 
listing of emulator functions.

Button definitions are saved automatically when you close the button window or document, or when you change 
button sets.



Button Run Application Browse Dialog

When defining or editing a button to assign an application to it, selecting the  button lets you look through 
your drives and directories for applications.    You can let Smartcom sort through program and batch files, or select 
All Files in the List Files of Type box.

Use the Directories box to move through your directories, and the Drive box to select disk drives.    For details on 
selecting file names, directories, and disks, see the topic Using Browse Screens. 

Select the name of the program to run when the button is clicked on, and use the  button to assign it to the 
button.



Send Break

Select Send Break from the Special menu to send a break signal to the remote system.

A break is a signal of a certain duration.    It is interpreted by different remote systems in different ways.    Depending 
on the remote system, the break signal might be used as a command, for example, to:

· interrupt an operation in progress
· break a connection
· get the system's attention. 

If the remote system is supposed to respond to a break signal in a certain way but doesn't, try increasing the duration 
of the break signal, which can be adjusted by selecting Terminal at the Settings menu, and changing the value in 
Sustain break signal for   €   centiseconds  .



Reset Emulator

If the emulator is placed into graphics mode unintentionally, the keypad acts as function keys when you want it to 
type its face-value characters, or the display in any other way appears to behave in a mode other than the one you 
want, select the Special menu's Reset Emulator command.    This restores the emulator to its default condition. 

Resetting the emulator also clears local flow control.    If Smartcom receives stray characters that it interprets as flow 
control, resetting the emulator will allow you to exchange data again.    One symptom that might result from the 
misinterpretation of stray characters is that the display freezes.    If it does, resetting the emulator may cure this 
problem.



Starting a Connection

To begin communicating, click on the  button (keyboard shortcut: Shift-Ctrl-Z).

If you're using a document set up to Originate a call (the standard setting in place when using a new, Untitled 
document), you're asked to supply a phone number.    Then a call progress screen is displayed to keep you informed 

of the progress of the connection attempt.    (Double-clicking on the  button skips the phone number dialog box, 
useful when you've already recorded a phone number with the Connection menu's Phone Number setting.)

If the Connection menu is set to Answer, clicking  sets up the modem to pick up the phone on incoming calls.    
The call progress display shows the steps in the answer process.

If the Connection menu's Direct Connect option is selected, clicking  begins communications immediately.    
The program doesn't try to dial with a modem, but simply opens the computer's port for communications with a 
connected device.

For more details on settings and online operations, see the topic Settings and Online Techniques.



Save Changes Dialog

You've made setting changes to the open communications document, either one you opened or a new, Untitled one. 
If you tell Smartcom to open a different document, create a New document, or exit the program before you've used 
the File menu's Save or Save As command to store the changes to disk, Smartcom alerts you that your changes will 
be discarded if you don't save them.

To save changes, press Enter or use the  button. 

If you're saving an Untitled document to disk, you'll be prompted to name the communications document, assigning 
it a file name under which to store the settings.    If you've made changes to an existing document, Smartcom simply 
saves the setting changes under the existing document name.

If you don't want to store changes to disk, use the  to discard the changes, or the 

 button to return to the open communications document.



Quitting While Connected

You are exiting the Smartcom program while you still have a live connection.    If you choose to exit now, Smartcom 
will disconnect you automatically.    If you cancel the program exit, you're returned online.

If you're online with a service or bulletin board that has logoff procedures that you have not completed, you may 
wish to cancel quitting and complete them.



Call Progress

Smartcom keeps you up to date on the progress of your connection attempt.    If it fails, you can use the Retry button 
to attempt the connection again.    If you're set up to automatically retry connections when they fail or are lost, the 
call progress dialog automatically shows you that Smartcom is waiting the specified time to make the retry.    You 
can set up retries and the amount of time Smartcom waits between retries by pulling down the Settings menu and 
selecting Modem.

If you need to cancel a connection attempt in progress, use the  button.



Receive File Progress Box

When receiving a file, Smartcom keeps you up to date on the transfer's progress.

Some file transfer protocols let Smartcom know how large a file is being transferred to your computer.    When this 
is the case, the progress box will display information letting you know what percentage of the file has been 
transferred and an estimated time to completion.    If the file transfer protocol you're using does not transfer file size 
information to Smartcom at the beginning of the transfer, Smartcom simply keeps track for you of the time it is 
taking to receive the file, how much information has been received, and the number of retried blocks.

Retried blocks are packets of information that Smartcom tried to receive but couldn't.    The reason for the retry may 
be that Smartcom had to reject the block because it detected an error with the data, or the remote system didn't send 
the block in time. 

If the number of consecutive retried blocks reaches the limit set for the selected file transfer protocol, Smartcom 
abandons the file receive process.    This can occur with a very noisy phone line, or when the remote system is 
sending files with a different file transfer protocol from the one you are using to receive.    You and the remote 
system must use the same protocol to be able to transfer files.    If you don't both use the same one, the transfer 
process will always time out.    When this occurs, try another file transfer protocol, or contact the remote system 
operator to find out which one is being used on that end.

A file transfer protocol is selected by pulling down the Settings menu and choosing File Transfer Protocol.    The 

retry limit is set by selecting the  button at File Transfer Protocol settings dialog box. 



Send File Progress Box

When sending a file, Smartcom keeps you up to date on the transfer's progress.

The progress box displays information letting you know what percentage of the file has been transferred, how much 
remains to be sent and an estimated time to completion.    Smartcom also keeps track of the time it is taking to send 
the file, how much information has been sent, and the number of retried blocks.

Retried blocks are packets of information that Smartcom tried to send but couldn't.    The reason for the retry may be 
that the remote system had to reject the block because it detected an error with the data, or Smartcom didn't send the 
block in time. 

If the number of consecutive retried blocks reaches the limit set for the selected file transfer protocol, Smartcom 
abandons the file sending process.    This can occur with a very noisy phone line, or when the remote system is 
attempting to receive files with a different file transfer protocol from the one you are using to send.    You and the 
remote system must use the same protocol to be able to transfer files.    If you don't both use the same one, the 
transfer process will always time out.    When this occurs, try another file transfer protocol, or contact the remote 
system operator to find out which one is being used on that end.

A file transfer protocol is selected by pulling down the Settings menu and choosing File Transfer Protocol.    The 

retry limit is set by selecting the  button at File Transfer Protocol settings dialog box. 



Getting Session Status

Smartcom keeps track of statistics about the current communications session, including connect time for the session 
and for the day, and information about communication settings in effect.    These statistics are accessed by double-

clicking on the status bar  located in the bottom left of the horizontal scroll bar.    To put 
away the display, click on the 

 button.



Phone Number Dialog

When you click on  to start a connection, and the Connection menu is set to Connect Through Phone and 
Originate, Smartcom displays the Phone Number dialog box.    If you've used the Connection menu's Phone Number 
setting to record a phone number for the communications document, it is displayed in the box, and clicking 

 starts the session by dialing it.

You can also record multiple phone numbers for communications documents.    This is useful when a remote system 
has alternate numbers you can call when the first line tried is busy.

To record multiple numbers, use the  button.    This brings up the Edit Phone Number List dialog box, in 
which you can record multiple phone numbers.

Once you've got a list of numbers recorded, at the Phone Number dialog box you can use the drop-down text box to 

select one of them to dial.    Click on the  button to display the list.    Highlight the one you want to dial, and click 

.

Bypassing the Phone Number Dialog Box

Once you've recorded a phone number for your document, you can bypass the Phone Number dialog box by double-

clicking on  to begin a connection.



Edit Phone Number List

Type or use the provided buttons to enter the digits of a phone number you want to add to your phone number list. 

The Phone Number can contain up to 76 characters (unless you have the Use reduced command set option selected 
in Modem Settings, in which case the limit is 38 characters). 

In addition to numeric characters, Smartcom can dial "customized" alphabetic phone numbers. Just enclose 
alphabetic characters in quotation marks, and they will be translated into the proper numeric equivalents. For 
example, you can enter a Phone Number as 800-"US HAYES" to dial 800-874-2937.

Once the phone number is entered, use the  button to place it on the list.

You can include multiple numbers on your list.    Enter a new number, then  it.

The phone list can be set up to dial a succession of phone numbers in rotation.    To add a number to the rotation, 

highlight the number on the list and  it.    Mark other numbers in the same fashion.    When dialing the first 
marked number doesn't get a connection, the next number is automatically placed in the Phone Number box.    This 
feature is especially useful when you're set up to automatically retry connections, with the If no carrier, redial   ð€  €     
time(s). setting.    Access this setting by selecting Modem at the Settings menu.

When you have numbers on your list, you can also:

· Change a number.    To do so, highlight the number on the list, type a new number in the text box, and click on 

.

· Delete a number.    Highlight it and click .

Once you've edited your list, click  to return to the Phone Number Dialog box.



Enter Script Name

Enter the script name.    When finished use the  button to complete the operation.    Or use the 

 button to abandon the operation.



Default File Transfer Directory

When working with the File Transfer Protocol settings dialog box, accessed via the Settings menu, you can use the 

 button to specify a default directory for Smartcom to use for file transfers.    This is convenient when 
transferring files, because you won't have to select different disk drives or directories, only the file names.

When specifying the default drive and/or directory, you can use the Directories box to move through your 
directories, and the Drive box to select disk drives.    For details on selecting directories and disks, see the topic 
Using Browse Screens. 

When you send or receive a file with the  or 

 button, Smartcom brings up a file selection dialog box.    In this box you choose the drive and directory to store 
the files you receive, or locate the files you want to send.    The default directory you've specified with the 

 option is the first one Smartcom suggests for you.    The standard setting, used in Untitled documents, is 
SCWIN\RCV, on the disk containing the Smartcom program files.    (You can always choose a different one, but the 
first one suggested is the one you specify with this option.)



Using Browse Screens

To select files, drives, and directories when performing Smartcom operations that require you to specify a file name 
or names:

You can type the name of the file into the File Name box.    If the operation permits use of wild card characters, as 
when receiving a batch of files with a file transfer protocol that supports multiple file transfers, you can enter them 
directly in the File Name box, for example, *.*

If files in the list under File Name are gray, you can't select them from the list.    This is because the operation does 
not normally require selection of existing files.    For example, when receiving a file with an error-free file transfer 
protocol, normally you won't want to specify an existing file name because it would overwrite (delete and replace) 
an existing file.    (You can do this if you want to, however.    Type the name of an existing file in the File Name box. 
Before letting you receive the file, Smartcom will ask you if you're sure you want to overwrite an existing file.)

If file names on the list are dark, you can select them.    You can also select different directories and disk drives to 
locate files using the mouse or keyboard:

Mouse Selection

To select a file name from the list, click on it to place it in the File Name box.    Double-clicking on a file name 
selects that file and automatically starts the operation.    (For example, when sending a file, double-clicking on the 
file name selects it and automatically starts the file transfer.)

The current directory is displayed as .    To select a different one, double-click on 
 (a closed subdirectory) or on 
 (the open, top directory). 

To select a different disk drive, click on  to drop down the list, and then click on the drive to select.

Keyboard Selection

Use the Tab key to move from one box to another.    For example, press Tab to move from the File Name box to the 
list of file names.

To select a file, use the up or down arrow key to highlight the one you want, and then press the space bar to place it 
in the File Name box.

The current directory is displayed as .    To select a different one, use the up or down arrow key to highlight an 
entry containing a 

 (a closed subdirectory) or 
 (the open, top directory).    Then press Enter.    When the highlighted entry is the current directory (for example: 

), pressing Enter starts the operation using the current File Name entry. 

To select a different disk drive, Tab to the Drives box, use the down arrow key to display the Drives list, and press 
the down arrow key again until the drive you want is highlighted.    Press Tab to accept that drive.



Normal is the standard selection, and has two purposes.    Most often it used to select no special autotype protocol.    
Text transfer is paced using the flow-control protocol selected for all the communication document's text 
transmissions, which includes what you type at the keyboard.    The document's flow-control protocol is selected 
with the Settings menu's Speed & Format option.    Note that if you select None for your flow-control protocol in 
Speed & Format, and Normal for your autotype protocol, no protocol is used at all, and Smartcom transmits text as 
fast as it can.

Its other purpose is to let you slow down text transmissions using a time delay between the transmission of each 
character.    This option is typically only used when you're online with a system that doesn't implement any of the 
selectable document flow-control protocols or autotype protocols.    To introduce a time delay, use the Protocol 
Settings button.



Send lines protocol is for use with systems that receive information a line at a time.    Many remote system text 
editors and electronic mail editors work this way.    Each time you finish a line of text, you press a carriage return to 
begin the next line.    When autotyping a file, Smartcom knows the remote system is ready for the next line when it 
receives a line feed character.    If the remote system begins each line with a prompt character, such as a > or :, you 
can adjust the character Smartcom looks for with the Protocol Settings button.



Await character echo is for use with systems that don't implement one of the communication document flow-
control protocols nor the autotype Send Lines protocol, but do echo back characters to you.    Each time Smartcom 
receives an echo of the last character it sent, it knows the remote system is ready to receive the next character.    You 
can fine tune the pacing of this text transfer method with the Protocol Settings button.



Phone Book Dialog 

The Phone Book provides a directory of communications documents indexed by telephone number.    In the dialog 
box you can highlight the document you want to work with, and make a connection with it or edit its settings.    You 
can also perform File menu operations: create New documents and Copy a document (same as the File menu's Save 
As command).

You can use the  button to start a connection to the remote system with the highlighted phone book entry.

Use the  button to display the Quick Settings dialog, where you can access the most frequently used 
setting options.

The  button lets you search for documents stored in other directories.

If you have multiple phone numbers stored in a document (entered by selecting Phone Number on the Connection 
menu and using the Edit List button), the main number is indexed in the Phone Book dialog.    The main number is 
the one that appears in text box of the Phone Number dialog box.



Phone Book 

The Phone Book provides a directory of the phone numbers stored in your communications documents.    This is an 
alternate method of locating and using the documents, indexed by phone number.    You can access the Phone Book 

with the Connection menu's Phone Book option, or, when using a button set that includes the  button, by 
clicking on that button.    This displays the Phone Book dialog box.






